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In diesem Handbuch...

Dieses Handbuch enthilt Anweisungen fiir die ersten
Schritte, den Gebrauch, die Behebung von Problemen und
die Wartung Ihres Agilent Microarray-Scannersystems.

1  Einfiihrung

In diesem Kapitel werden der Microarray-Scanner und die
notwendigen Maflnahmen vor seinem Betrieb beschrieben.

2  Erste Schritte

In diesem Kapitel erhalten Sie Anweisungen fiir den sicheren
Betrieb des Microarray-Scanners sowie fir die Einrichtung
und das Scannen von Objekttragern mit dem Agilent Scan-
Steuerungsprogramm.

3 Andern der Scan-Einstellungen

Dieses Kapitel behandelt die Scan- Einstellungen und wann
und wie Sie diese dndern kénnen.

4  Verwenden der Werkzeuge

In diesem Kapitel erfahren Sie, wie Sie Profile
(Gruppierungen von Scan- Einstellungen), Scan- Bereiche und
automatische Ein-/Ausschaltzeiten fiir den Laser einrichten.

5 Wartung und Fehlerbehebung im System

Dieses Kapitel beschreibt Wartungsverfahren und -tipps
sowie Fehlermeldungen fiir die Behebung von Fehlern in
Ihrem System.

6 Referenz

Dieses Kapitel enthilt Spezifikationen fiir die Objekttrager
und Informationen zur Einhaltung rechtlicher Bestimmungen.
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Ein leistungsstarkes
Gerit...

System-
beschreibung

Arbeitsweise

Agilent G2565CA Microarray-Scannersystem
(Scan Control Software 8.3)
Benutzerhandbuch

1
Einfiihrung

Ein leistungsstarkes Gerat fiir Microarray-Analysen 10
Systembeschreibung 11
Arbeitsweise 17

Dieses Kapitel enthilt eine allgemeine Einfiithrung zum
Agilent G2565CA Microarray- Scannersystem.

In diesem Abschnitt werden die leistungsstarken Funktionen
des Microarray-Scanners beschrieben, der Lésung fir
Microarray- Analysen von Agilent.

Dieser Abschnitt behandelt Hardware- und Software-
funktionen des Microarray-Scanners, Teile- und System-
anforderungen, Mafnahmen fiir die Standortvorbereitung
und Sicherheitsrichtlinien.

In diesem Abschnitt wird die Funktionsweise des
Microarray- Scanners erliutert.

~£7%- Agilent Technologies



1 Einfithrung

Ein leistungsstarkes Gerat fiir Microarray-Analysen

Der Agilent Microarray- Scanner G2565CA ist eine Kompo-
nente der Losung fir Microarray- Analysen von Agilent Tech-
nologies. Der Microarray-Scanner ist ein anspruchsvoller
Scanner, der mit laserinduziertem Fluoreszenzverfahren
arbeitet. Er ermdéglicht das Auslesen von Microarrays, die auf
Objekttragern der StandardgrofRe 76 mm x 26 mm gedruckt
sind.

Der Microarray-Scanner misst die Fluoreszenzintensitit der
markierten Probe von der an die Microarrays gebundenen
Nukleinsdure (DNA und RNA). Da die Fluoreszenz von zwei
Farbstoffen gleichzeitig gemessen werden kann, erleichtert
dies die Durchfiihrung von zweifarbigen Microarray- Unter-
suchungen. Diese Technologie ermoglicht ein schnelles, hoch-
wertiges, automatisches Scannen von Microarrays.

Abbildung 1 Agilent Microarray-Scanner G2565CA

Jeder Objekttrager wird innerhalb von Minuten ausgelesen
und die Dateien werden fiir die Merkmalsanalyse vorbereitet.
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Systembeschreibung

Einfithrung 1

Dieser Abschnitt enthilt Aufzihlungen der Hardware- und
Softwarefunktionen, Teile und PC- Anforderungen sowie eine
physische Beschreibung des Scanners und Informationen zur
Standortvorbereitung und Sicherheit.

Hardware- und Softwarefunktionen

Teileliste

Der Microarray-Scanner hat folgende Funktionen:
¢ Interne und externe Funktion zum Lesen von Strichcodes
¢ Dynamischer Autofokus

¢ Automatische Kalibrierung der PMT- Verstarkung vor jedem
Scan-Vorgang

¢ Kontinuierliche Stabilisierung der Laserleistung
e 2, 3, 5 oder 10 Mikrometer Pixelgrofde

¢ Dynamischer Bereich von >10% fiir einzelne Scan- Vorginge
im 16-Bit- Scan- Modus, >10° fiir einzelne Scan- Vorginge
im 20- Bit-Scan-Modus und >10° fiir duale Scan- Vorginge
im 16-Bit- Scan- Modus (XDR)

¢ Komprimierung von TIFF-Bilddateien

¢ Spezifikationen zum Sicherstellen einer Gleichmifiigkeit
von <56% VK (Variationskoeffizient)

Die Scan-Steuerungssoftware ermoglicht die Auswahl

des Farbstoffkanals (Fluoreszenz), des Scan-Bereichs, der
Auflosung, des dynamischen Bereichs, der PMT- Verstiarkung
und des Ausgabeordners fiir jeden Objekttrager im Karussell.
Diese Einstellungen konnen automatisch tiber gespeicherte
anwendungsspezifische Profile geladen oder individuell
ausgewahlt werden.

Das Agilent Microarray-Scannersystem G2565CA besteht aus
folgenden Komponenten:

¢ Microarray- Scanner

Agilent Microarray-Scannersystem G2565CA (Scan-Steuerungssoftware 8.4) — Benutzerhandbuch 11



1

12

Einfithrung

¢ Karussell und 50 Halter fiir Objekttrager

¢ PC- Arbeitsplatz mit Wiederherstellungssoftware auf CD
¢ Stromkabel und USB-Kabel

¢ Scan- Steuerungssoftware 8.4 (Scan Control Software)

¢ Merkmalsextraktionssoftware 10.x (Feature Extraction
Software)

¢ Konformitatserklarung

Agilent Scan-Steuerungssoftware 8.4 ist fiir die Verwendung
mit Agilent Merkmalsextraktionssoftware 9.5 und hoéher kon-
zipiert. 5- und 10-Mikrometer-, 16-Bit-Scanvorginge sind
abwartskompatibel mit FE 9.5. 2- und 3-Mikrometer- sowie
alle 20-Bit-Scanvorginge erfordern FE 10.x.

PC-Systemanforderungen

Uberpriifen Sie, ob Sie iiber folgende fiir die Installation und
Verwendung der Agilent Scan- Steuerungssoftware
notwendigen Voraussetzungen verfiligen:

Software
e Windows XP Professional mit SP2 oder Windows Vista 32
mit SP1

¢ Internet Explorer 5.5 oder hoher

Hardware

¢ Pentium IV 3,2 GHz oder hoher

e 2 GB RAM erforderlich (4 GB RAM erforderlich, falls die
Merkmalsextraktionssoftware auf dem gleichen PC
installiert ist)

e 250 GB verfiigbarer Plattenspeicherplatz fiir Programme
und Datengenerierung

Agilent Microarray-Scannersystem G2565CA (Scan-Steuerungssoftware 8.4) — Benutzerhandbuch



Einfiihrung 1

Physische Beschreibung des Scanners

Vorderansicht des Scanners

Liiftung und
Abdeckung Abdeckung

|

Statusanzeige ___|

Ein-/Aus- 1 —— 5
Schalter T

Abbildung 2 Microarray-Scanner, Vorderansicht

Ansicht von oben auf den Scanner
Arm zum

Abdeckung automatischen Beladen

Hinweis-
aufkleber

Karussell-
trdager

Abbildung 3 Microarray-Scanner, Ansicht von oben
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Einfithrung

Riickansicht des Scanners

Liiftung
ﬁ_ \ SE———— 5, Netzsicherungshalter
Netzspannung
ﬁ’/ Anzeigefenster
| Netzspannungseinstellung
? \
\'\ 7/— \\ Netzsteckdose

USB-Anschluss
Lasersicherungshalter

Abbildung 4 Microarray-Scanner, Riickansicht

Vorbereiten des Geratestandorts

Stellen Sie sicher, dass in der
Umgebung die ,,Microarray-
Scannerspezifikationen” auf
Seite 108 aus Kapitel 6 erfiillt sind. ok i
Wenn Sie Fragen haben, wenden
Sie sich an Ihr Agilent Vertriebs-
und Supportcenter oder besuchen .
Sie uns auf www.agilent.com/ s'°hfr' dass
geniigend Platz
chem/dnasupport. fiir das Offnen
und SchlieBen
der Abdeckung
vorhanden ist. ]

Stellen Sie das e _)K_
Gerat auf einen —
stabilen Laboﬂis% I

Stellen Sie
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Einfithrung 1

Sicherheitssymbole auf dem Scanner

2 Symbol VORSICHT
Das Produkt ist mit diesem VORSICHT-Symbol gekennzeich-

net, wenn es fiir den Benutzer notwendig ist, sich auf diese
Anweisungen in der Produktdokumentation zu beziehen,
um eine mogliche Gefahr zu erkennen. Es wird auf einen
Betriebsablauf, ein Vorgehen o. 4. aufmerksam gemacht, die
bei falscher Ausfithrung zur Beschidigung des Produkts oder
zum Verlust wichtiger Daten fiihren kénnen.

f Symbol WARNUNG
Das Produkt ist mit diesem WARNUNG- Symbol gekennzeich-

net, wenn gefiahrliche Spannungen oder elektrische Schlige
auftreten konnen. Nur geschultes Servicepersonal sollte
Arbeiten in diesem Bereich durchfiihren.
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1 Einfithrung

Sicherheitsrichtlinien

Der Agilent Microarray-Scanner G2565CA ist auf Sicherheit
und Benutzerfreundlichkeit ausgerichtet. Lesen und beachten
Sie vor der Inbetriebnahme des Microarray-Scanners alle
Warnungen und Hinweise.

m Versuchen Sie nicht, die internen Teile des Microarray-Scanners zu
reparieren oder auf diese zuzugreifen. Andernfalls konnten Sie sich
selbst Hochspannung und gefahrlicher Laserstrahlung aussetzen.

Das Entfernen der Abdeckungen fiihrt dazu, dass die Garantie
ungiiltig wird.

m Der Microarray-Scanner muss an eine geerdete Steckdose
angeschlossen werden. Eine Schutzerdung ist fiir die Sicherheit

erforderlich.

Wenn Sie den Microarray-Scanner das erste Mal einschalten oder ihn
an einen anderen Standort gestellt haben, miissen Sie sich vergewis-
sern, dass die Spannungswerte korrekt eingestellt sind und die Span-
nungsquelle geerdet ist.

Agilent empfiehlt, den Microarray-Scanner auf einen stabilen
Labortisch zu stellen. Der Microarray-Scanner selbst kann Vibrationen
erzeugen und empfindlich auf externe Vibrationen reagieren.

Der Microarray-Scanner kann empfindlich auf kondensierende Luft-
feuchtigkeit reagieren. Befolgen Sie die in der Produktdokumentation
genannten Sicherheitsvorkehrungen. Weitere Informationen erhalten
Sie unter , Tipps zur Vermeidung von Problemen™ auf Seite 81 in Kapi-
tel b und Spezifikationen zur relativen Luftfeuchtigkeit finden Sie unter
Seite 108 in Kapitel 6.
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Arbeitsweise

Einfithrung 1

In diesem Abschnitt werden die Betriebsfunktionen des
Agilent Microarray-Scanner G2565CA beschrieben.

Positionierung der Objekttriager

Der Microarray-Scanner kann in seinem herausnehmbaren
Karussell bis zu 48 Objekttriager der Grofle 76 mm x 26 mm
aufnehmen. Wahrend eines Karusselldurchlaufs werden die
Objekttrager nacheinander in die Position zum Scannen
gebracht, gescannt und dann zuriick in das Karussell
befordert.

Laseranregung

Scannen

Der Microarray-Scanner arbeitet mit zwei Lasern, einem
SHG-YAG-Laser (632 nm) und einem Helium-Neon- Laser
(633 nm). Die Laser regen mit Cyanine-3 (Cy-3) und
Cyanine-5 (Cy-5) markierte RNA oder DNA an, um die
Fluoreszenz nach der Hybridisierung der Zielnukleinsiure
auf den Microarray-Sonden zu messen. Farbstoffe, die Cy-3
und Cy-5 adhneln wie z.B. die Farbstoffe Alexa 647, 555 und
660, konnen ebenfalls verwendet werden.

Der Microarray-Scanner wurde fiir einen grof3en Storabstand
in den Emissionsbanden Cy-3 (5650 - 610 nm) und Cy-5
(650 - 750 nm) optimiert, mit einem weiten Dynamikbereich
(bis zu finf Zehnerpotenzen) und geringem spektralem Uber-
sprechen. Dies ermoéglicht die Messung von zahlreichen
Zielkonzentrationen und sorgt fiir eine hohere Datenzuver-
lassigkeit bei niedrigeren Frequenzen.

Die Lasererregung wird schnell tiber das Microarray vor und
zuriick gescannt. Der dynamische Autofokus zur Nachverfol-
gung sorgt dafiir, dass das Microarray immer in der Brenn-
ebene der Scan-Linse positioniert ist, um GleichméaRigkeit
beim Scannen sicherzustellen.
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Einfithrung

Fluoreszenzdetektion

Die Fluoreszenz von den markierten Proben wird durch
einen Hochleistungs-PMT in ein elektrisches Signal
umgewandelt. Verstirker mit niedrigen Frequenzen und
digitale Integratoren verarbeiten das PMT-Signal zu digitalen
Messwerten, die in einer TIFF-Datei erfasst werden.

Dunkelstromsubtraktion

Bei sehr niedrigen Frequenzen kénnen Stérungen negative
Pixelwerte erzeugen. Anstatt diese Werte auf null zu setzen,
wodurch es zu einer fehlerhaften Messung kommen kénnte,
addiert der Agilent Scanner einen niedrigen Versatz zu allen
Pixelwerten, sodass die gesamte Pixelverteilung erfasst
werden kann. Dieser konstante Versatz stellt keine Stérung
dar und wird von der Agilent Merkmalsextraktionssoftware
statistisch korrekt wieder abgezogen.
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2 Erste Schritte

Lizenzierung

Fir den Agilent Scanner werden zwei
Konfigurationsoptionen angeboten:

die standardméafige Konfiguration fir hochauflésendes
Scannen oder

ohne Hochauflésungsfunktion

Ohne die Lizenz fiir hochauflésendes Scannen stehen

die Optionen 10 Mikrometer und 5 Mikrometer sowie

5 Mikrometer fiir den dualen Scan-Vorgang zur Verfiigung.
Die Optionen 2 und 3 Mikrometer kénnen nicht ausgewahlt
werden.

Falls Sie die Hochauflosungsfunktion erworben haben, beno-
tigen Sie zur Aktivierung dieser Funktion die Softwarelizenz.
In den meisten Fillen installiert das fiir die Installation
zustindige Fachpersonal die Lizenz fiir Sie. Ist dies nicht der
Fall oder wird die Funktion nachtriglich erworben, folgen
Sie den unten beschriebenen Anweisungen, um die Software-
lizenz einzul6sen.

Einlosen der Lizenz fiir hochauflosendes Scannen

Fiithren Sie folgende Schritte aus, um die Lizenz fiir
hochaufléosendes Scannen einzul6ésen:

1 Halten Sie das Softwareberechtigungszertifikat griffbereit,
das mit dem Scanner geliefert wurde.

2 Offnen Sie die Seite https://software.business.agilent.com/
index.stm.

3 Wihlen Sie die Option Click here to start software
license redemption (Klicken Sie hier, um die
Softwarelizenz einzulésen).

4 Folgen Sie den Anweisungen, um Ihre Lizenz einzulésen.
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Erste Schritte 2

Installieren lhrer Lizenz fiir hochauflosendes Scannen
Wenn Sie Ihre Lizenz per E-Mail erhalten haben, fiihren Sie
folgende Schritte aus, um die Lizenz zu installieren:
1 SchlieRen Sie das Fenster der Scan-Steuerungssoftware.

2 Suchen Sie die Lizenzdatei und verschieben Sie sie in
folgendes Verzeichnis:

C:\Programme\Agilent\Microarray
3 Starten Sie die Scan-Steuerungssoftware neu.

Die Optionen 2 und 3 Mikrometer stehen nun zur
Verfiigung.
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2 Erste Schritte

Lizenz fiir Nicht-Agilent-Strichcodes

Falls Sie Strichcodes in einer Auflésung mit 2 oder 3 Mikro-
meter scannen miissen, die nicht von Agilent stammen, wen-
den Sie sich an Agilent, um eine spezielle Lizenz fiir den
Zugriff auf diese Funktion zu erhalten.

Ist auf einem Objekttriger kein Strichcode vorhanden oder
erkennt der Scanner den Strichcode nicht als Agilent Array
und soll das Array mit 2- oder 3-Mikrometerauflosung
gescannt werden, liberspringt der Scanner den Objekttriger
und gibt folgende Meldung aus, wenn diese Lizenz nicht
erworben wurde:

.~ Scan settings or slide is not supported by the current scanner
license. Contact Agilent via pdl-non_ag_barcode®@agilent.com to
obtain license to scan non-Agilent barcodes in high-resolution®.
(Die derzeitige Scannerlizenz unterstiitzt die Scan-Einstellungen
oder den Objekttrager nicht. Senden Sie iiber pdl-non_ag_
barcode@agilent.com eine E-Mail an Agilent, um eine Lizenz zum
Scannen von Nicht-Agilent-Strichcodes mit hoher Auflosung zu
erhalten.)

Beziehen und Installieren einer Lizenz fiir Nicht-Agilent-
Strichcodes

1 Senden Sie eine E-Mail mit der Seriennummer im Textfeld
an PDL-non_ag_barcode@agilent.com und Sie erhalten
unmittelbar eine Lizenz. Diese Lizenz muss jedes Jahr
erneuert werden.

2 Wenn Sie die Lizenz erhalten haben, verschieben Sie sie in
folgendes Verzeichnis:

C:\Programme\Agilent\Microarray

3 SchlieRen Sie die Scan-Steuerungssoftware und starten
Sie sie neu.

Der Scanner erkennt die neue Lizenz.
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Inbetriebnahme des Scanners

Schritt 1. Einschalten des Agilent Microarray-Scanners

4 Schalten Sie den Microarray-Scanner iiber den Ein-/Aus-
Schalter an der Vorderseite des Gerats ein. Sie werden
Folgendes bemerken:

a Ein Lifter wird eingeschaltet und die Abdeckung wird
verriegelt.

b Der Microarray-Scanner durchlauft eine Initialisie-
rungsroutine, die ungefihr vier Minuten dauert. Wah-
rend der Initialisierung wird ein Selbsttest ausgefiihrt.
Hierbei blinkt die Statusanzeige, da verschiedene Funk-
tionsprifungen durchgefithrt werden.

¢ Die Laser werden erst eingeschaltet, wenn Sie die
Scan- Steuerungssoftware starten.

Status- % 1| /lﬂ
— P I

anzeige _
ﬁ=:\'
# e wrrErTES a ::eﬁuu

T =

D

Ein-/Aus- _____|
Schalter

Abbildung 5 Ein-/Aus-Schalter und Statusanzeige

Weitere Informationen dariiber, b Doppelklicken Sie auf das Symbol Agilent Scan Control,
wie die Laser automatisch ein- und um das Scan-Steuerungsprogramm zu O6ffnen.
ausgeschaltet werden, erhalten Oder

Sie unter ,,Festlegen von Zeiten
zum Ein-/Ausschalten der Laser”
auf Seite 72 in Kapitel 4.

Klicken Sie auf Start > Programme > Agilent > Scan
Control.

Abbildung 6 . Agilent Scan Control” Symbol
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Wenn das Programm gestartet wird, beginnen die Laser
mit der Aufwiarmphase.

6 Prifen Sie unten im Hauptfenster die Meldung Scanner

status.
Initialisieren Der Scanner wird initialisiert. Wenn die Initialisierung
des Scanners abgeschlossen ist, wird der Scannerdeckel entriegelt und

die Laser fahren mit der Aufwirmphase fort.

Aufwarmphase Die Aufwarmphase der Laser dauert etwa 30 Minuten.
der Laser Wenn Sie auf das Aufwiarmen der Laser warten miissen,
gehen Sie zu ,Schritt 2. Einlegen der Objekttriager in die
Halter“ auf Seite 26.

Laser sind Wahlen Sie Tools > Laser Auto ON/OFF Settings... und
ausgeschaltet klicken Sie auf Turn Lasers ON Now, um die Laser
einzuschalten.
Scanner ist Sie konnen mit dem Scan-Vorgang beginnen.

betriebshereit
Sie kénnen einen Karusselldurchlauf nur starten, wenn beide

Laser aufgewarmt sind.
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Schritt 1. Einschalten des Agilent Microarray-Scanners
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Abbildung 7 Hauptfenster des Scan-Steuerungsprogramms bei
betriebsbereiten Lasern

Agilent Microarray-Scannersystem G2565CA (Scan-Steuerungssoftware 8.4) — Benutzerhandbuch 25



2 Erste Schritte

Schritt 2. Einlegen der Objekttrager in die Halter

Objekttrager miissen in einen Halter eingelegt werden, bevor
sie in das Karussell geladen werden koénnen. Die Halter
schiitzen den Objekttrager wihrend des Scan-Vorgangs.

Abbildung 8 Einlegen der Objekttrager in die Halter

Fingerabdriicke fiihren zu Fehlern 1 Halten Sie den Halter fiir die Objekttriager mit den Seiten
bei der Fluoreszenzdetektion. nach oben, auf denen das Agilent Logo abgebildet ist.
Fassen Sie die ijekttr ager fir 2 Legen Sie einen Daumen auf die Mitte der Abdeckung des
genaue Ergebnisse nur an den Halters.

Kanten an und arbeiten Sie bei der
Handhabung der Objekttrager
immer mit Handschuhen.

3 Dricken Sie die Abdeckung vorsichtig nach unten und
schieben Sie sie in Richtung Vorderseite des Halters, bis
sie entriegelt ist.

Beschriften Sie die Objekttrager

zudem nicht und kleben Sie keine
anderen Etiketten auBer dem Weitere Informationen zum Entfernen der Objekttrager

entsprechenden Strichcode auf die erhalten Sie unter ,Schritt 5. Entfernen der Objekttriager® auf
Objekttréager. Seite 37.
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Entriegelte Abde-
ckung des Halters fiir
Objekttrager

Abbildung 9 Entriegeln der Abdeckung

4 Legen Sie den Objekttriager in den Halter, sodass das Ende
des Objekttriagers an der Riickseite auf der Kante aufliegt.

Die aktive Microarray-Oberfliche muss nach oben zeigen.
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Weitere Informationen zum
Anbringen eines zweiten lesbaren
Strichcodes erhalten Sie unter
.Spezifikationen zum Strichcode
und Strichcodeetikett” auf

Seite 112.

Aktive Microarray-
Oberflache

Kante des Halters

Abbildung 10 Ordnungsgeméale Platzierung des Objekttragers an der

Kante

b Legen Sie den Objekttriger ordnungsgemifl in den Halter:

Das Ende ohne Strichcodeetikett liegt an der Kante an
der Riickseite an.

Der Objekttrager liegt mit der Oberfliche nach oben,
auf der das Microarray aufgebracht ist. Das Microarray
wird durch das Glas gescannt.

Stellen Sie sicher, dass diese Regeln eingehalten werden,
wenn Sie den Objekttriager ausrichten.

Agilent Objekttrager verfiigen uUber zwei Strichcodes,
einem auf jeder Seite des Glases. Siehe Abbildung 11.
Normalerweise verfiigen Nicht- Agilent- Objekttriger nur
iber einen Strichcode. Platzieren Sie die Objekttragerseite
mit dem aktiven Microarray so, dass sie nach oben in
Richtung des Deckels des Halters zeigt.

Wenn bei einem Objekttrager der Spot nicht auf der Seite
des Objekttragers mit dem Strichcode liegt, kann der
Scanner den Strichcode nicht lesen.
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Ein nicht ordnungsgemal eingelegter Objekttrager kann zu
Beschadigungen am Microarray-Scanner fiihren.

Double-barcoded slide example

=
=l
s=
SIDE 1 S = Inactive Glass Surface
S=
S
sl
-
=
]
= = Active Active
SIDE 2 §= Microarray Microarray
= Surface Surface
u
-

Abbildung 11 Beide Seiten des Objekttragers

6 Lassen Sie das andere Ende des Objekttrigers los und
lassen Sie es in den Halter fallen.

Der Objekttrager kann leicht auf den Nasen an der Seite
des Halters aufliegen.

Nase

Abbildung 12 Objekttrager fallt in den Halter
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7 Driicken Sie die Abdeckung des Halters vorsichtig mit
Threm Daumen nach unten, um sie zu schlief3en.

Abbildung 13 SchlieRen der Abdeckung

8 Um die Abdeckung einzurasten, schieben Sie sie vorsichtig
mit IThrem Daumen zuriick, bis sie einrastet.

Abbildung 14 Einrasten der Abdeckung
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Schritt 1. Einschalten des Agilent Microarray-Scanners

9 Prifen Sie, dass die Abdeckung des Halters
ordnungsgeméifd eingerastet ist.

Unter den seitlichen
Nasen eingerastete
Abdeckung

Abbildung 15 Ordnungsgemal eingerastete Abdeckung
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Schritt 3. Laden der Halter in das Karussell

Der Microarray-Scanner scannt die
Objekttrager in der Reihenfolge, in
der sie erkannt werden, wahrend
das Karussell in die Richtung der
Steckplatze mit aufsteigender
Nummerierung rotiert. Im
Karusselldurchlauf werden

leere Steckplatze ibersprungen.

Wenn die Objekttrager ordnungsgemaf in die Halter eingelegt
wurden, konnen Sie die Halter in das Karussell laden. Das
Karussell ist so konzipiert, dass die Halter problemlos richtig
geladen werden kénnen. Die Halter kdnnen mit dem
Karussell in den Scanner geladen oder aus dem Scanner
entnommen werden.

1 Laden Sie einen Halter in den Karussellsteckplatz 1, den
ersten Steckplatz im Uhrzeigersinn von der
Ausgangsposition.

Legen Sie keinen Objekttrager in den Ausgangssteckplatz.
Der Ausgangssteckplatz ist breiter als die anderen
Steckplatze und ist mit ,Home“ beschriftet.

2 Stellen Sie sicher, dass das spitz zulaufende Ende des
Halters auf die Mitte des Karussells zeigt.

3 Stellen Sie sicher, dass der Halter fest im
Karussellsteckplatz sitzt.

Spitz zulau-
fende Enden
zeigen auf die
Mitte

'y

/

Iy;

“

}
U Ausgangs-
" | steckplatz

Steck-
platz 1

Abbildung 16 Karussell

Eine unsachgemalie Platzierung der Halter im Karussell kann zu
schweren Beschadigungen am Microarray-Scanner fiihren.
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4 Ist das Karussell bereits montiert, gehen Sie zu Schritt 5.
Ansonsten montieren Sie das Karussell.

Falls Sie die Halter in ein Karussell gesteckt haben, das
aus dem Microarray- Scanner herausgenommen wurde,
fithren Sie folgende Schritte aus, um das Karussell wieder
einzubauen.

a Montieren Sie das Karussell so, dass die Ausrichtungs-
stifte auf dem Karusselltrager im Microarray- Scanner in
die Locher im Karussell passen.

Richten Sie das das Karussell so aus, dass der D-
formige Stab in der Mitte des Karusselltragers in das
D-férmige Loch im Karussellboden passt, und setzen
Sie das Karussell vorsichtig gerade nach unten in den
Scanner ein.

b Stellen Sie sicher, dass das Karussell fest montiert ist.

Achten Sie bei der Montage des Karussells darauf, dass Sie mit dem
Karussell nicht gegen den Arm zum automatischen Beladen des
Karussells stoRen. Dadurch kann es zu Ausrichtungsfehlern kommen.

Wenn Sie das Karussell manuell drehen miissen, machen Sie dies
nur, wenn das Gerat ausgeschaltet ist. Andernfalls kann es zu
Beschadigungen am Gerat kommen.

b (Optional) Positionieren Sie den Karusselldeckel iiber das
Karussell, bis die zwei seitlichen Nasen einrasten.
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Nasen

Ausgangs-
steckplatz

Abbildung 17 Karusselldeckel

6 SchlieRen Sie die Abdeckung des Scanners.

Sie koénnen folgende Aufgaben nicht ausfiihren, solange
die Abdeckung nicht geschlossen ist:

Den Scanner initialisieren
Nach leeren Steckplitzen im Karussell suchen
Strichcodes vor dem Karusselldurchlauf lesen

Einen Karusselldurchlauf starten

Starre Ausrichtungsstifte Locher fiir die starren Ausrichtungsstifte

Bewegliche Ausrichtungsstifte Lacher fiir die beweglichen Ausrichtungsstifte

Abbildung 18 Ausrichtungsstifte und Locher im Scanner und Karussell
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Falls eine Fehlermeldung im Karussellprotokoll erscheint, die
auf eine Betriebsunterbrechung des Motors hinweist, kann es
sein, dass die Ursache ein nicht ordnungsgeméifd montiertes
Karussell ist. ﬁberprﬁfen Sie die Ausrichtung des Karussells
und bauen Sie es ggf. erneut ein.
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Schritt 4. Scannen der Objekttrager

Ein Scan-Vorgang bezeichnet das  Fiihren Sie die unten aufgefiihrten Schritte aus, um Ihre
Erzeugen eines Abbilds der Proben auf  Objekttréiger fiir das Scannen vorzubereiten und um einen
einem einzigen Objekttrager. Ein - Karusselldurchlauf zu starten. Weitere Informationen finden

Karusselldurchlauf bezeichnet das  Gje jm nichsten Abschnitt, ,Scannen der Objekttriger®.
Scannen aller gekennzeichneten

Objekttrager im Karussell. ~ ,Schritt 1. Festlegen der Platzierung der Steckplitze“ auf
Seite 40

,Schritt 2. Einrichten eines Profils zum Bearbeiten aller
Einstellungen in der Scan-Tabelle“ auf Seite 41

,Schritt 3. Andern einzelner Scan- Einstellungen in der Scan-
Tabelle“ auf Seite 42

,Schritt 4. Starten des Karusselldurchlaufs“ auf Seite 44

»Schritt 5. I"Jbertragen von Dateien und Archivieren von
Daten“ auf Seite 48
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Schritt 5. Entfernen der Objekttrager

Nachdem der Karusselldurchlauf beendet ist, konnen Sie die
Halter aus dem Karussell entnehmen und anschlieRend die
Objekttrager aus den Haltern entfernen.

1 (Optional) Nehmen Sie das Karussell aus dem Scanner.

Nehmen Sie das Karussell nicht heraus, wenn sich der
Arm zum automatischen Beladen des Karussells tiber dem
Karussell befindet. Folgen Sie stattdessen den Anwei-
sungen unter ,Fehlerbehebung, wenn sich der Arm zum
automatischen Beladen tiber dem Karussell befindet® auf
Seite 92.

2 Nehmen Sie die Halter aus dem Karussell.
3 Nehmen Sie die Objekttriger aus den Haltern.

a Halten Sie den Halter fiir die Objekttrager mit den
Seiten nach oben, auf denen das Agilent Logo
abgebildet ist.

b Legen Sie einen Daumen auf die Mitte der Abdeckung
des Halters.

¢ Driicken Sie die Abdeckung vorsichtig nach unten und
schieben Sie sie in Richtung Vorderseite des Halters, bis
sie entriegelt ist.
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Entriegelte Abdeckung
des Halters fiir Objekt-
trager

d Driicken Sie das Ende des Objekttriagers mit dem
Strichcode von der Unterseite des Halters nach oben,
um Fingerabdriicke in dem Bereich mit der Probe zu
vermeiden.

e Fassen Sie den Objekttriager an den Seiten an und
entnehmen Sie ihn aus dem Halter.

Von unten driicken

Abbildung 19 OrdnungsgeméRes Entfernen des Objekttragers
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Schritt 6. Festlegen von Zeiten fiir das automatische
Ausschalten der Laser

Sie kénnen die Lebensdauer der Laser verlingern, indem die
Gerate zu bestimmten Zeiten automatisch ausgeschaltet
werden. Siehe ,Festlegen von Zeiten zum Ein-/Ausschalten
der Laser® auf Seite 72 in Kapitel 4, ,Verwenden der
Werkzeuge*, fiir weitere Informationen.

Der Microarray-Scanner muss nicht ausgeschaltet werden.

Falls Sie den Scanner abschalten moéchten, fithren Sie
folgende Schritte aus:

1 Klicken Sie auf Exit im Hauptfenster des Scan-
Steuerungsprogramms.

Schlief3en Sie das Scan-Steuerungsprogramm vor
dem Ausschalten des Microarray-Scanners, um
unvorhergesehene Ubertragungssperren zu vermeiden.

2 Warten Sie einige Sekunden und stellen Sie sicher, dass
die Abdeckung des Microarray- Scanners nicht verriegelt
ist.

3 Offnen Sie die Abdeckung.

4 Schalten Sie den Microarray-Scanner iiber den Ein-/Aus-
Schalter an der Vorderseite des Gerats aus.

Offnen Sie die Abdeckung nur, wenn Sie gehért haben, wie diese
entriegelt wurde. Wenn Sie versuchen, die Abdeckung wahrend des
Entriegelns zu 6ffnen, kann dies zu einem Stau im Microarray-Scanner
fihren.
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Scannen der Objekttrager

Schritt 1. Festlegen der Platzierung der Steckplatze

Wenn Sie alle Objekttrager in allen 48 Steckplitzen scannen
mochten, gehen Sie zu ,Schritt 2. Einrichten eines Profils
zum Bearbeiten aller Einstellungen in der Scan-Tabelle“ auf
Seite 41.

1 Geben Sie im Feld Start slot die Nummer des Steck-
platzes ein, der den ersten Objekttriger zum Scannen
enthalt.

2 Geben Sie im Feld End Slot die Nummer des Steckplatzes
ein, der den letzten Objekttrager zum Scannen enthélt.

sigteior [ll=]  Emsa [& -

Die Auswahl an Steckplitzen, die Sie in den Schritten 1 und
2 eingegeben haben, wirkt sich auf die meisten Funktionen
im Hauptfenster des Scan- Steuerungsprogramms aus.

¢ Nur die Auswahl der Steckplitze, die hier eingegeben
wird, wird in der Scan-Tabelle angezeigt.

¢ Der Scanner scannt nur die Objekttriger der Auswahl, die
hier eingegeben wurde.

¢ Mit dem Befehl Carousel Check wird nur die Auswahl
an Steckplitzen auf leere Steckplitze und Agilent-
unterstiitzte Strichcodes gepriift, die hier eingegeben
wurde. (Siehe ,Priifen auf Agilent- unterstiitzte Strichcodes
und leere Steckplitze“ auf Seite 55 in Kapitel 3.)
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Schritt 2. Einrichten eines Profils zum Bearbeiten aller
Einstellungen in der Scan-Tabelle

Ein Profil ist eine Sammlung von Scan-
und Bildeinstellungen, anhand derer,
wenn sie ausgewahlt sind, die Scan-

Tabelle mit Werten gefiillt wird, die im

Profile Editor eingegeben wurden.

<default>

AgilentHD_GX_2Color
AgilentHD_GX_1Color
AgilentHD_CGH
AgilentHD miRNA
AgilentG3_CGH

e Wiahlen Sie in der Profilliste eines der vorhandenen
Profile aus.

Frofle: | EF TN - |

Wenn Sie das Hauptfenster des Scan-Steuerungsprogramms
o6ffnen, sehen Sie die Spalten, die mit den Werten der Scan-
Einstellungen gefiillt sind. Diese Werte werden anhand

des letzten Profils festgelegt, das vor dem Schlief3en des
Programms fiir einen Durchlauf ausgewahlt wurde.

Agilent liefert sechs vorkonfigurierte Profile zur Auswahl
und Verwendung mit Agilent High- Density- Microarrays,
Agilent G3 Microarrays und Nicht- Agilent- Microarrays.

Standardeinstellungen, die nach der Programminstallation
verfligbar sind

Agilent HD- Genexpressions- Microarrays mit 2 Farben
Agilent HD- Genexpressions- Microarrays mit 1 Farbe
Agilent HD- CGH/CNV/ChIP- Microarrays

Agilent HD- miRNA- Microarrays

Agilent G3-CGH/CNV/ChIP- Microarrays

Um alle Einstellungen in einem Schritt zu dndern, kénnen
Sie eines der Agilent Profile auswéhlen oder ein eigenes aus
den vorhandenen Profilen erstellen (einschliefRlich des Profils
<Default>).

Weitere Informationen zum Andern eines vorhandenen
Profils oder Erstellen eines eigenen Profils erhalten Sie in
Kapitel 4 unter ,Bearbeiten eines vorhandenen Profils“ auf
Seite 63 oder ,Erstellen eines neuen Profils“ auf Seite 64.
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Schritt 3. Andern einzelner Scan-Einstellungen in der Scan-

Tabelle

Wenn Sie keine Einstellungen in der tber das ausgewéihlte
Profil erzeugten Scan-Tabelle &ndern miissen, warten Sie,
bis die Meldung Scanner status anzeigt, dass der Scanner
betriebsbereit ist, und fahren Sie mit ,Schritt 4. Starten des
Karusselldurchlaufs“ auf Seite 44 fort.

1 Klicken Sie auf die Zelle(n), deren Einstellung(en) Sie
andern mochten.

Klicken Sie auf eine einzelne Zelle oder
Klicken Sie auf eine Spalteniiberschrift oder

Markieren Sie mehrere Zellen in einer Spalte, um
zusammenhingende Zellen auszuwihlen. Rechts neben
der ersten ausgewihlten Zelle wird ein Pfeil angezeigt.

Driicken Sie Strg und wahlen Sie mehrere nicht zusam-
menhingende Zellen in einer Spalte aus. Rechts neben
der letzten ausgewihlten Zelle wird ein Pfeil angezeigt.

2 Wahlen Sie aus der Liste eine neue Einstellung aus.

Die neue Einstellung wird in Fettschrift angezeigt.

In der Statuszeile unten im Hauptfenster des Scan-Steuerungsprogramms
wird die geschatzte GesamtdateigroRe und Laufzeit angezeigt. Beachten
Sie, dass geniigend Speicherplatz auf dem C-Laufwerk fir wahrend des
Scan-Vorgangs erzeugte temporare Dateien vorhanden sein muss. Uber-
schreitet die geschétzte BildgroRe zuziiglich der DateigroRe den verfiig-
baren Speicherplatz, wird der Karusselldurchlauf vom Scanner nicht
freigegeben.
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Agilent empfiehlt, dass Sie einen Ausgabepfad zum Speichern der
Bilddateien auf einem lokalen Laufwerk auswahlen. Wenn Sie ein
Netzwerklaufwerk fir Ihren Ausgabepfad angeben und die Netzwerk-
verbindung zusammenbricht, werden die Ordner auf dem C-Laufwerk
in der Datei Programme\Agilent\Microarray\NetDataBackup
gespeichert.
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Schritt 4. Starten des Karusselldurchlaufs

Wahrend eines Karusselldurchlaufs werden alle ausgewahlten
Objekttrager im Karussell gescannt.

1 Uberpriifen Sie, ob die Meldung Scanner status im
Hauptfenster anzeigt, dass der Scanner betriebsbereit ist.

Der Karusselldurchlauf kann nicht gestartet werden, wenn
die Aufwarmphase der Laser noch nicht vollstindig
abgeschlossen ist.

2 Klicken Sie im Hauptfenster des Scan-
Steuerungsprogramms auf Scan Slot m-n.

Der Buchstabe m steht fiir den Steckplatz mit dem ersten
Objekttrager und n fir den Steckplatz mit dem letzten
Objekttrager.

Zwei Vorginge werden ausgefiihrt, wenn der Scan- Vorgang
gestartet wird:

Die Abdeckung des Scanners wird verschlossen.

Das Dialogfeld ,Scan Progress“ wird geoffnet und zeigt
den Status des Scan-Vorgangs an.

i~ Cammmd scan mlomiaton

Fils rismin eMLPMBMNTERL SLOTM_ 801 &

Hacumls 15U 1l Bt

Slnt rumsher: 1
- Blakm

BRSO ﬂ

Lef

Pangeess -

S peogeesy 1%

Ll progress 01X (Dol 1 shes frrf e

Wiew Fepolt bet | =0

Abbildung 20 Dialogfeld ,,Scan Progress”
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Das Karussellprotokoll enthalt Scan-
Informationen und Meldungen zu
Fehlern, die wéhrend des
Karusselldurchlaufs aufgetreten sind.

Erste Schritte 2

Die Meldungen im Fenster ,Status“ des Dialogfelds ,Scan
Progress“ enthalten Informationen zum Status des Scan-
Vorgangs und Karusselldurchlaufs.

Wenn der Karusselldurchlauf beendet ist, wird im Feld
»Status“ die Meldung ,Carousel run completed“ angezeigt.

Am Ende eines Karusselldurchlaufs wird automatisch das
Karussellprotokoll angezeigt.

AGILENT SCANNER -- CAROUSEL REPORT LOG

Scanmer 5N: US1470PPEL

Fri Apr 11 11:01:38 2008

Caronsel mm requested from Slot 1 to Slot 29

Total mumber of slide(s) detected: 2%,

Slot 1

Scanmed image: D New Folider US1470I'PEL 1234567553012 50 1.6f

Scan completed,

Scanned mage: I New Folder TS1470PPEL_IS1554817004 S01.660

Scan completed.

Scammed image: T New Talder TS 1470PPTIL_2S1554819556 5016

Scan completed,

Scanned image: I New Folder TS1470PPEL_IS1554819%00 S0 1. 660

Scan completed.

Abbildung 21 Karussellprotokoll

Falls Sie das letzte Karussellprotokoll 6ffnen mochten,
nachdem Sie das Dialogfeld ,Scan Progress® geschlossen
haben, finden Sie das Protokoll unter folgendem Pfad:

C:\Programme\ Agilent\Microarray\Logs\CarouselRunLog.htm

Die Datei wird jedes Mal tiberschrieben, wenn ein neuer
Karusselldurchlauf gestartet wird.
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2 Erste Schritte

Weitere Informationen finden Sie
im Schnellstarthandbuch der
Merkmalsextraktionssoftware in
Ihren Scannerunterlagen.

Nachdem der Durchlauf beendet ist, konnen Sie die
Objekttrager entnehmen. Siehe ,Schritt 5. Entfernen der
Objekttrager® auf Seite 37.

Anzeigen des Karussellprotokolls wahrend eines Durchlaufs

Sie kénnen das Karussellprotokoll jederzeit wihrend des
Karusselldurchlaufs anzeigen.

¢ Klicken Sie im Dialogfeld ,Scan Progress“ auf View
Report.

Priifen der Daten nach dem Karusselldurchlauf oder
wihrenddessen

¢ Nachdem die Daten fiir einen Scan-Vorgang iibertragen
wurden, konnen Sie die Datei in der Agilent Merkmals-
extraktionssoftware oder einem anderen Programm anzei-
gen.

Falls Sie FE 10.x auf der Festplatte eines anderen PCs installiert haben,
miissen Sie die Bilddateien nach dem Durchlauf auf dieses Laufwerk
iibertragen. Siehe , Schritt 5. Ubertragen von Dateien und Archivieren von
Daten” auf Seite 48.

Abbrechen eines Scan-Vorgangs

Sie kéonnen den Scan-Vorgang oder den Karusselldurchlauf
jederzeit anhalten.

e Klicken Sie im Dialogfeld ,Scan Progress“ auf Abort.

Folgende Meldung wird angezeigt.

Carousel Run Abort x|

@ Do you wank to abort the carousel run now?

Click fes to abort the run now; you may lose scan data.
Click Mo to abort the run after the current scan is done.
Click Cancel to cancel your abort command.

Yes I Mo | Cancel |

Abbildung 22 Meldung Giber das Abbrechen eines Karusselldurchlaufs
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Erste Schritte 2

Es konnen eine oder zwei Minuten vergehen, bis der
Microarray- Scanner den Scan-Vorgang vollstindig
abgebrochen hat, nachdem ,Yes“ ausgewiahlt wurde.
Gesammelte Daten werden fiir spitere Analysen gespeichert.
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2 Erste Schritte

Schritt 5. Ubertragen von Dateien und Archivieren von Daten

¢ Verschieben Sie die Dateien ggf. nach dem Durchlauf in
einen anderen Ordner.

Sie haben folgende Moglichkeiten zum Speichern der Datei
oder Dateien:

In einem neuen Ordner im urspringlichen Ordner auf
dem lokalen Laufwerk, das Sie fiir den Ausgabepfad
eingerichtet haben

In einem anderen Ordner auf den lokalen Laufwerk
In einem Ordner im Netzwerk

Hier miissen Sie die Daten auf den PC iibertragen, auf
dem das Merkmalsextraktionsprogramm installiert ist.

Auf CD oder DVD

Jeder PC- Arbeitsplatz ist mit einem DVD-Brenner
ausgestattet.

Es ist wichtig, Daten regelméaRig vom PC des Scanners zu archivieren,
um sicherzustellen, dass ausreichend Plattenspeicherplatz fiir zukiinf-
tige Durchlaufe verfligbar ist. Ist wenig Speicherplatz vorhanden, halt
der Microarray-Scanner den Scan-Vorgang an und es wird ein Hinweis
angezeigt.

Durch regelmaRiges Defragmentieren des Festplattenlaufwerks
konnen Sie die Leistung steigern.
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Agilent G2565CA Microarray-Scannersystem
(Scan Control Software 8.3)
Benutzerhandbuch

3
Andern der Scan-Einstellungen

Andern von Einstellungen der Scan-Tabelle 50
Andern von Einstellungen der Scan-Tabelle tiber Profile 51
Andern von einzelnen Einstellungen der Scan-Tabelle 52
Einstellungen der Scan-Tabelle 54

Bevor Sie die Objekttrager scannen, kénnen Sie die Scan-
oder Bildeinstellungen adndern.

In diesem Kapitel werden zunichst die einzelnen
Einstellungen der Scan-Tabelle beschrieben und dann
erlautert, wie Sie diese einzeln oder alle in einem Schritt
andern konnen.
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Andern der Scan-Einstellungen

Andern von Einstellungen der Scan-Tabelle

Ein Profil ist eine Sammlung von Scan-
und Bildeinstellungen, anhand derer,
wenn sie ausgewahlt sind, die Scan-

Tabelle mit Werten geftillt wird, die im

50

Profile Editor eingegeben wurden.

Sie haben zwei Moglichkeiten, die Einstellungen der Scan-
Tabelle zu dndern:

« Andern aller Einstellungen in einem Schritt tiber ein
Profil

« Andern einzelner Scan-Einstellungen iiber Dropdownlisten

in der Scan-Tabelle

Sie kéonnen die Eintriage in beliebiger Reihenfolge dndern.
Um Zeit zu sparen, sollten Sie die Eintrige in folgender
Reihenfolge bearbeiten:

a Falls Sie Nicht- Agilent- Objekttrager scannen, finden Sie

weitere Informationen unter ,Erstellen eines neuen
Scan- Bereichs mit dem Scan Region Editor“. Ein benut-
zerdefinierter Scan-Bereich ist besser auf IThre Objekt-
trager abgestimmt, als die in der Scan-Tabelle oder im
Profile Editor zur Verfiigung stehenden Bereiche.

Unabhéngig davon, ob Sie Agilent oder Nicht- Agilent-
Objekttrager scannen, finden Sie weitere Informationen
unter ,,Andern von Einstellungen der Scan-Tabelle liber
Profile“. Hier wird ein anderes Profil ausgewahlt.

¢ Wenn Sie ein anderes Profil ausgewahlt haben

(oder eins bearbeitet bzw. erstellt haben), finden Sie
weitere Informationen unter ,Andern von einzelnen
Einstellungen der Scan-Tabelle“.

Falls Sie ein anderes Profil wiahlen, nachdem Sie die
Eintrage einzeln bearbeitet haben, werden geidnderte
einzelne Eintrige durch die Profileintrige
uberschrieben.

Stellen Sie sicher, dass die IDs der Objekttriger
entweder manuell oder automatisch nach der Auswahl
des Profils erfasst werden. Fiir Objekttriger ohne
Strichcode ist dies obligatorisch. Fiir Agilent
Objekttrager ist dies optional. Siehe ,Slide ID“ auf
Seite 54.

Weitere Informationen tiber die Scan-Einstellungen finden
Sie unter ,Einstellungen der Scan-Tabelle“ auf Seite 54.
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Andern der Scan-Einstellungen 3

Andern von Einstellungen der Scan-Tabelle iiber Profile

e Wihlen Sie in der Dropdownliste Profile das Profil,
dessen Einstellungen fiir den Durchlauf verwendet werden
sollen.

Profie [P ERET - |

Abbildung 23 Dropdownliste ,Profile” im Hauptfenster des Scan-
Steuerungsprogramms

Sie kénnen die Einstellungen fiir das markierte Profil
bearbeiten (siehe ,Bearbeiten eines vorhandenen Profils“ auf
Seite 63) oder darauf aufbauend ein neues Profil erstellen
(siehe ,Erstellen eines neuen Profils“ auf Seite 64).

Wenn Sie das Hauptfenster des Scan-Steuerungsprogramms
offnen, sehen Sie die Spalten, die mit den Werten der Scan-
Einstellungen gefiillt sind. Diese Werte werden anhand des
Profils festgelegt, das zuletzt vor dem Schlief3en des
Programms fiir einen Durchlauf gewihlt wurde.

Agilent liefert sechs vorkonfigurierte Profile zur Auswahl
und Verwendung mit Agilent High- Density- Microarrays,
Agilent G3 Microarrays und Nicht- Agilent- Microarrays.

AgilentHD_GX_2Color Agilent HD- Genexpressions- Microarrays mit 2 Farben
AgilentHD_GX_1Color Agilent HD- Genexpressions- Microarrays mit 1 Farbe
AgilentHD CGH Agilent HD- CGH/CNV/ChIP-Microarrays
AgilentHD_miBRNA  Agilent HD- miRNA-Microarrays
AgilentG3_CGH Agilent G3-CGH/CNV/ChIP- Microarrays

Fir Agilent Objekttrager wahlen Sie das Profil, das zu Ihrem
Agilent Microarray- Scanner passt.

Fiir Nicht- Agilent- Objekttriger miissen Sie Anderungen an
den einzelnen Einstellungen der Scan-Tabelle vornehmen.
Oder Sie erstellen basierend auf dem vorhandenen Profil ein
neues.
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Andern der Scan-Einstellungen

Andern von einzelnen Einstellungen der Scan-Tabelle

Die Scan-Tabelle erméglicht es Thnen, Eintrage fiir einzelne
Objekttrager oder Objekttriagergruppen zu bearbeiten. Wahlen
Sie hierzu ein Element im Dropdownmenii aus, das fiir jede
Spalte auRer den Spalten ,Slide ID“ und ,Description®
angezeigt wird.

1 Klicken Sie auf die Zelle(n), deren Einstellung(en) Sie
andern mochten.

Klicken Sie auf eine einzelne Zelle oder
Klicken Sie auf eine Spalteniiberschrift oder

Markieren Sie mehrere Zellen in einer Spalte, um
zusammenhingende Zellen auszuwahlen.

Rechts neben der ersten ausgewahlten Zelle wird ein
Pfeil angezeigt.

Driicken Sie Strg und wahlen Sie mehrere nicht
zusammenhingende Zellen in einer Spalte aus.

Rechts neben der letzten ausgewihlten Zelle wird ein
Pfeil angezeigt.

2 Klicken Sie auf den Pfeil, um die Dropdownliste
anzuzeigen, und wihlen Sie eine Einstellung.

Sean Mlagon ]

Abbildung 24 Dropdownliste fir die Einstellungen des Scan-Bereichs

Die gednderten Einstellungen werden in Fettschrift angezeigt.

Beschreibungen zu den Einstellungen dieser Spalten finden
Sie unter ,Einstellungen der Scan-Tabelle“ auf Seite 54.
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Andern der Scan-Einstellungen 3

Zuriicksetzen von Einstellungen der Scan-Tabelle auf aktuelle
Profilwerte

Bei den Profilwerten, die beim Zuriicksetzen angezeigt
werden, handelt es sich um die urspriinglichen Werte des
ausgewahlten Profils.

1 Klicken Sie auf die Zelle(n), deren Einstellung(en) Sie
zuriicksetzen mochten.

Klicken Sie auf eine einzelne Zelle oder
Klicken Sie auf eine Spalteniiberschrift oder

Markieren Sie mehrere Zellen in einer Spalte, um
zusammenhingende Zellen auszuwahlen, oder

Driicken Sie Strg und wihlen Sie mehrere nicht
zusammenhingende Zellen in einer Spalte aus oder

Klicken Sie auf die Uberschrift Slot in der oberen
linken Ecke der Tabelle, um alle Zellen in der Scan-
Tabelle zu markieren.

2 Klicken Sie mit der rechten Maustaste auf den markierten
Bereich und wéahlen Sie Reset to Profile Value.

Reset bo Profils Yalie

Fi Cobarrares ) Lo Wirdow
Bt Fit Cobamn Ses

Rfresh Tabie

Abbildung 25 Kontextmenii zum Zuriicksetzen aller markierten
Einstellungen auf ihre urspriinglichen Werte im aktuellen
Profil

Die Einstellungen im aktuellen Profil werden im markierten
Bereich angezeigt.
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3 Andern der Scan-Einstellungen

Einstellungen der Scan-Tabelle

In diesem Abschnitt werden die Einstellungen in der
Scan-Tabelle beschrieben, die bearbeitet werden koénnen.
Anschliefiend wird erlautert, wie diese bearbeitet werden
koénnen.
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2 ceddet Rl Aggerd HO 51 ) Bl i W WO WO HeMDR  DSeerdrels
1 chtedseen  Baf Apient HD 61 1 21 B Hum N 0% ML cedDRs  DeASeanDals
i shuodsect: N+0 Agleni HD (61 w2t fom]  Sum a0k 100% 100k shosDf:  D'\Scanliala
5 cupdeess Rl Aigfert HD (1 w71 feres]  Siem W 0T WO cNoRDRe  DrASeadiaa
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Abbildung 26 Hauptfenster des Scan-Steuerungsprogramms und Scan-Tabelle mit vorkonfigurierten
Profileinstellungen

Slide ID Die Objekttriager-ID ist eine Bezeichnung fiir den
Objekttrager. Die Eintrige unter ,Slide ID“ werden fiir den
Namen der Bilddatei verwendet, falls dies im aktuellen Profil
angegeben ist. Siehe ,Naming prefix 1 und Naming prefix 2¢
auf Seite 64.

Automatischer Eintrag Falls Thre Objekttriager tber
Strichcodes verfligen, die die Spezifikationen unter
SSpezifikationen zum Strichcode und Strichcodeetikett® auf
Seite 112 erfiillen, miissen Sie die Objekttriger-ID vor dem
Karusselldurchlauf nicht in die Scan-Tabelle eingeben. Die
Funktion ,Auto detect in der Spalte ,Slide ID“ zeigt an,
dass der Scanner die Agilent- unterstiitzten Strichcodes
automatisch beim Scannen des Objekttrigers in die Scan-
Tabelle einliest.

Sie kéonnen die Objekttrager-ID auch manuell eingeben.
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Andern der Scan-Einstellungen 3

Manueller Eintrag IDs fiir Objekttrager ohne Strichcode oder
mit nicht unterstiitzten Strichcodeformaten miissen tuber die
Tastatur oder ein geeignetes externes Strichcodelesegerit
eingegeben werden.

Wenn Sie die ID uber die Tastatur eingeben, doppelklicken
Sie zunichst auf die Zelle ,Slide ID“, bevor Sie den
Strichcode oder eine eindeutige Textbezeichnung eingeben.

Priifen auf Agilent-unterstiitzte Strichcodes und leere Steckplitze

Um von Agilent unterstiitzte Strichcodes anzuzeigen und
nach leeren Steckplitzen in der Spalte ,Slide ID“ zu suchen,
klicken Sie auf ,Tools > Carousel Check®.

Das Programm tuberpriift das Karussell zundchst auf leere
Steckplatze und schreibt fiir leere Steckplitze ,No chip®
in jede Zelle unter ,Slide ID“. Anschlief3end liest das
Programm die Strichcodes fiir alle Objekttrager aus und
schreibt sie in die Zellen unter ,Slide ID*.

Dye channel Mit dem Farbstoffkanal wird festgelegt, ob Informationen nur
fir rot (z.B. der Farbstoff Cy-5), nur fir griin (z.B. der
Farbstoff Cy-3) oder fiir beide Farbstoffkanile gesammelt
werden. Diese Auswahl hat keine Auswirkungen auf die
Scan- Zeit. Ist allerdings nur ein Farbstoffkanal ausgewéahlt,
kann sich die Dateigrofle halbieren.

Scanregion Der Scan- Bereich legt den zu scannenden Bereich des
Objekttragers fest. Der Bereich sollte so groff sein, dass er
den gesamten Druckbereich des Microarrays umfasst, aber so
klein, dass nicht zu nah am Strichcode oder anderen nicht
transparenten Grenzbereichen des Objekttragers gescannt
und die Autofokus-Funktion des Scanners nicht beeintrichti-
gt wird. Eine Minimierung des Scan-Bereichs verringert
aufRerdem die Scan-Zeit und spart Speicherplatz.

Agilent stellt einen Scan-Bereich zur Verfiigung, der

den Anforderungen aller Agilent High- Density- und G3-
Objekttrager entspricht, und einen weiteren, der den
Anforderungen fiir Scan-Vorginge von ganzen Objekttriagern
der Grofle 76 mm x 26 mm ohne Strichcodeetikett
entspricht.
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Scan resolution
(um)

TIFF file
dynamic range

Fir Nicht- Agilent- Objekttrager miissen ggf. kundenspezifi-
sche Scan-Bereiche verwendet werden, die die Anforderun-
gen des Druckbereichs besser erfiillen. Siehe ,Erstellen eines
neuen Scan-Bereichs mit dem Scan Region Editor“ auf
Seite 69.

Die Scan- Auflosung (PixelgrofRe) kann auf 2, 3, 5 oder
10 Mikrometer festgelegt werden.

Fir Scan-Vorgiange mit 10 Mikrometern stellt jede Reihe von
Pixeln im TIFF-Bild den Durchschnittswert zweier Scan-
Linien dar, eine fiir jede Richtung. Fir Scan-Vorginge mit 5,
3 und 2 Mikrometern konnen duale Scan-Vorgiange zum
Ermitteln dieses Durchschnittswerts gewihlt werden oder
nur eine Scan-Linie pro Bildreihe erfasst werden.

Mit dieser Einstellung kann der dynamische Bereich auf 16
oder 20 Bit eingestellt werden. Fir den Scanner G2565CA
wurde der dynamische Bereich des PMTs und der signalver-
arbeitenden Elektronik erweitert. Durch die Auswahl der
Option fiir eine 20-Bit-TIFF-Datei erhalten Sie Zugriff auf
diesen erweiterten Bereich. Dies ermoglicht die Quantifizie-
rung von hohen und niedrigen Frequenzen in einem einzigen
Scan-Vorgang.

Die Scan-Steuerungssoftware erméglicht weiterhin
konventionelles XDR- 16- Bit-Scannen, wie nachfolgend
beschrieben.

Die folgende Tabelle zeigt den Speicherplatz und die Scan-
Zeit fir einzelne und duale Scan-Vorginge fir die jeweilig
gewiahlte Auflésung an, d.h. fiir einen dynamischen TIFF-
Bereich mit 16 Bit oder mit 20 Bit. Der Scan-Bereich betragt
61 mm x 21,6 mm.

Die Statusleiste unten im Hauptfenster des Scan-Steuerungs-
programms zeigt den geschétzten Speicherplatz und die
geschitzte Laufzeit fir den kompletten Karusselldurchlauf.
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Tabelle 1 Speicherplatz und Scan-Zeit fiir einzelne und duale Scan-
Vorgénge fiir den Agilent HD-Scan-Bereich 61 mm x 21,6 mm

Auflésung Speicherplatz, Speicherplatz, Scan-Zeit,
MB, 16 Bit MB, 20 Bit min.
Einzeldurchgang mit2 1300 1600 20

Mikrometern

Einzeldurchgang mit3 620 760 15
Mikrometern

Einzeldurchgang mit5 200 300 8
Mikrometern

Einzeldurchgang mit 10 52 115 8
Mikrometern

Doppeldurchgang mit2 1300 1600 40
Mikrometern

Doppeldurchgang mit3 620 760 30
Mikrometern

Doppeldurchgang mit5 200 300 16
Mikrometern

Duale Scan-Vorginge erfordern nicht mehr Speicherplatz als
einzelne Scan-Vorginge, aber dauern doppelt so lange.
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3 Andern der Scan-Einstellungen

Red PMT Gain  Uber diese Einstellungen kann der Empfindlichkeitsgrad der
und PMTs des roten und griinen Kanals eingestellt werden. Der
Green PMT Gain PMT ermittelt die von dem Microarray abgesonderte
Fluoreszenz.

Das Standardausgangssignal (100%) setzt die Verstarkung auf
das werksseitig kalibrierte Signal; hierbei handelt es sich um
die empfohlene Einstellung fiir Agilent Microarrays. Die
jeweiligen Farbkanaleinstellungen kénnen unabhingig davon
auf 1% gesetzt werden.

Ist ein Microarray so hell, dass das obere Ende des Aus-
gangssignals gesattigt ist, kann die PMT-Empfindlichkeit auf
einen Empfindlichkeitsbereich heruntergesetzt werden,
sodass alle Informationen gelesen werden konnen.

XDR Ratio Bevor der dynamische TIFF-Dateibereich mit 20-Bit zur Ver-
fiigung stand, musste die XDR-Funktion ,eXtended Dynamic
Range“ fiir beide Scanner und die Merkmalsextraktionssoft-
ware verwendet werden, um alle gescannten Daten zwischen
Merkmalen mit sehr niedrigen und sehr hohen Frequenzen
zu erfassen. Nun kann als Alternative zu XDR mit dem
dynamischen TIFF-Dateibereich mit 20-Bit gearbeitet wer-
den, um die dynamischen Daten zu erfassen.

Wenn die XDR-Funktion aktiviert ist, scannt der Scanner
automatisch den gleichen Objekttriger zweimal mit unter-
schiedlicher PMT- Empfindlichkeit. So entstehen zwei mitein-
ander verknlipfte Bilder, die bei der Merkmalsextraktion
gleichzeitig bearbeitet werden kénnen, um einen einheit-
lichen Satz an extrahierten Intensititsdaten zu erhalten, die
bis zu 6+ Zehnerpotenzen abdecken.

Eine hohe Empfindlichkeit wird tber ,Red PMT Gain“ oder
,Green PMT Gain“ festgelegt. Ist die XDR-Funktion aktiviert,
wird sie bei Werten unter 10% automatisch deaktiviert.

Die Einstellung in der Spalte ,XDR ratio“ gibt an, ob der
Scanner einen zweiten Scan-Vorgang mit niedrigeren PMT-
Einstellungen durchfithren soll oder nicht. Sind die PMTs
fur rot und griin beispielsweise auf 100% und das XDR-
Verhaltnis auf 0,1 gesetzt, wird der zweite Scan-Vorgang mit
10% fiur die PMTs durchgefiihrt. Die niedrigste verfligbare
PMT- Einstellung betriagt 1%.
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Output path  Uber die Schaltfliche ,Browse“ kénnen Sie zum Speichern
der Daten aus jedem Scan-Vorgang ein Verzeichnis auswéih-
len. Agilent empfiehlt, dass die Daten in einem lokalen Ver-
zeichnis auf einer zweiten Festplatte erfasst werden. Dartliber
hinaus kénnen Sie auch ein Netzwerkverzeichnis auswéahlen.
Wird wahrend des Scannens ein Problem beim Netzwerkzu-
griff festgestellt, werden die Daten in einem temporiren
lokalen Verzeichnis gespeichert und ein Warnhinweis wird im
Karussellprotokoll angezeigt.

Slide Beschreibung der gescannten Objekttriger. Diese Informatio-
Description nen sind in der Datei enthalten, die in der Merkmalsextrak-
tionssoftware angezeigt werden kann.
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4
Verwenden der Werkzeuge

Erstellen/Bearbeiten von Profilen mit dem Profile Editor 63

Erstellen/Bearbeiten von Scan-Bereichen mit dem Scan Region
Editor 68

Festlegen von Zeiten zum Ein-/Ausschalten der Laser 72
Weitere Werkzeuge 75

Wenn Sie ein Profil oder einen Scan-Bereich erstellen bzw.
bearbeiten oder Zeiten fiir das automatische Ausschalten der
Laser festlegen mochten, konnen Sie die Werkzeuge im Menii
»Tools“ verwenden. In diesem Kapitel wird beschrieben, wie
Sie diese Werkzeuge verwenden:

Tools WEs

Profile Editor, ..
Scan Region Editar, ..
Laser Auko OM/OFF Settings. ..

Log File Finder. ..

Abbildung 27 Meni , Tools”
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Profile Editor

<Default>

AgilentHD_GX_2Color
AgilentHD_GX_1Color
AgilentHD_CGH
AgilentHD miRNA
AgilentG3_CGH

Scan Region

Editor

Lasers Auto
On/Off Settings

Der Profile Editor ermoglicht es Thnen, die Einstellungen fiir
alle mit der Software gelieferten Profile zu bearbeiten:

Das Profil, dessen Einstellungen bei der Installation sichtbar
sind

Agilent HD- Genexpressions- Microarrays mit 2 Farben
Agilent HD- Genexpressions- Microarrays mit 1 Farbe
Agilent HD- CGH/CNV/ChIP- Microarrays

Agilent HD- miRNA- Microarrays

Agilent G3-CGH/CNV/ChIP- Microarrays

Basierend auf den vorhandenen Profilen konnen auch neue
Profile erstellt werden.

Sie miissen moglicherweise Microarray- Bereiche scannen, die
nicht standardmifig installiert sind. Verwenden Sie den
Scan Region Editor, um neue Bereiche zu erstellen.

Um die Lebensdauer der Laser zu verldngern, kénnen Sie in
diesem Dialogfeld festlegen, dass die Laser zu bestimmten
Zeiten automatisch ausgeschaltet werden.
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Erstellen/Bearbeiten von Profilen mit dem Profile Editor

Bearbeiten eines vorhandenen Profils

Sie konnen vorhandene Profile bearbeiten und speichern. Sie
konnen zudem ein vorhandenes Profil bearbeiten und die
Anderungen unter einem neuen Profilnamen speichern.
(Siehe ,Erstellen eines neuen Profils“ auf Seite 64.)

1 Wihlen Sie in der Mentileiste Tools > Profile Editor
(Abbildung 27).

Profile Editor

Current Profile: <Default: Import ‘ Export J
=
Description Default configuration settings
Fl-Scan Settings
Drve chanmel R+i3 Save hs...
ScCan region Agilent HD (61 x 21.6mmm]) |
Sican resolution 5 um |
Tiff File dynamic range 16 bit | B g
Red PMT gain 100%
Green PMT gain 100%:
#DR Ratio =No xDR.=>
Cutput path o
Slide description
Marning prefix 1 <Instrument Serial # =
Maming prefix 2 <Slat # =
Compress Tiff Mo
Splitjrotate image Mo

Abbildung 28 Profile Editor

Agilent Microarray-Scannersystem G2565CA (Scan-Steuerungssoftware 8.4) — Benutzerhandbuch 63



4  Verwenden der Werkzeuge

Beachten Sie, dass das Profil 2 Wihlen Sie ein Profil zum Bearbeiten.
<default> nicht aus der Liste
entfernt werden kann. Alle
anderen Profile kénnen Sie
léschen, einschlieBlich der Profile,
die Sie aus dem Profil <default>
erstellt haben.

3 Andern Sie die Scan- und Bildeinstellungen mit den in
,Andern von Einstellungen der Scan-Tabelle“ auf Seite 50
und ,Nicht in der Scan-Tabelle vorhandene Profileinstel-
lungen® auf Seite 64 beschriebenen Optionen.

4 Klicken Sie auf Save.

Erstellen eines neuen Profils

Sie konnen aus einem beliebigen vorhandenen Profil ein
neues Profil erstellen, indem Sie das vorhandene Profil unter
einem neuen Namen speichern.

1 Wihlen Sie Tools > Profile Editor.

2 Wihlen Sie ein vorhandenes Profil aus, das Sie als neues
Profil speichern mochten.

3 Klicken Sie auf Save As, um die vorhandene Datei unter
einem neuen Namen zu speichern.

4 Geben Sie den Namen ein und klicken Sie auf Save.

5 Andern Sie die Scan- und Bildeinstellungen mit den in
,,Andern von Einstellungen der Scan-Tabelle“ auf Seite 50
und ,Nicht in der Scan-Tabelle vorhandene Profileinstel-
lungen® auf Seite 64 beschriebenen Optionen.

6 Klicken Sie auf Save.

Nicht in der Scan-Tabelle vorhandene Profileinstellungen

Die folgenden Einstellungen sind nicht in der Scan-Tabelle
enthalten. Diese Parameter gelten fiir alle Scan-Vorgiange im
Karusselldurchlauf.

Naming prefix 1  Fir Standard- Scan- Vorgdnge wird der Dateiname im Scan-
und Steuerungsprogramm aus drei Namensbestandteilen gebildet.

Naming prefix 2 Prefixl_Prefix2_ScanNumber.tif.
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Fir XDR-Scan- Vorgidnge wird dem Dateinamen ein
zusatzliches Segment (_H oder _L) hinzugefiigt, um XDR-
Hi- Bilder von XDR-Lo-Bildern zu unterscheiden:

Prefixl_Prefix2_ScanNumber_H tif
Prefixl_Prefix2_ScanNumber_L.tif

Bei der standardméafiigen Angabe fiir Prefixcl handelt es sich
um die Option Instrument Serial #, Sie konnen aber auch Slide ID
wihlen oder ein benutzerdefiniertes Prafix verwenden.

Bei der standardméafiigen Angabe fiir Prefixc2 handelt es sich
um die Option Slide ID, Sie konnen aber auch Slot # oder Scan
Date Time wihlen oder ein benutzerdefiniertes Prafix
verwenden.

El Image File Settings

Output path cil
Slide description
Marning prefix 1 <Instrument Serial # =
=] Maming prefix 2 £ uskomize= ;I
Customized <5lide ID >
Compress Tiff <5can DateTime =
Splitfrotate image <Slok # >

Slide ID - Ist diese Option ausgewéhlt, wird der Eintrag
in der Zelle ,Slide ID“ fiir den Dateinamen verwendet.
Steht der Eintrag <Auto detect> in der Zelle ,Slide ID,
wird der Strichcode fiir den Dateinamen verwendet.

Slot # - Die Nummer des Steckplatzes, in dem sich der
gescannte Objekttrager befindet

Scan DateTime - Ist diese Option ausgewéihlt, werden
Datum und Uhrzeit im Format YYYYMMDDHHMM
verwendet.

Customize - Geben Sie ein benutzerdefiniertes Prafix
ein, wenn Sie ,Customize® wihlen (hochstens
36 Zeichen).

Uber das Scan- Steuerungsprogramm wird die Scan- Nummer
automatisch zugewiesen.

Das Programm vergleicht den Dateinamen eines neuen
Scan-Vorgangs mit denen im gewéahlten Datenverzeichnis.
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Compress TIFF

Split/rotate
image

Ist Prefixl_Prefix2 eindeutig, wird die Scan-Nummer auf
S01 gesetzt.

Bei einer Ubereinstimmung wird die Scan-Nummer so
lange erhoht, bis der Dateiname eindeutig ist.

Beispiel
US4510PP02_251485023883_S03.tif

e Instrument Serial # = US4510PP02
e Slide ID = 251485023883

¢ ScanNumber = S03. Es handelt sich um die dritte Scan-
Datei im Verzeichnis mit den gleichen Angaben fiir
LSnstrument Serial #“ und ,Slide ID“.

Sie kénnen den von den Scan-Bildern genutzten
Speicherplatz reduzieren, indem Sie die TIFF-Dateien
komprimieren.

Der verwendete Komprimierunsalgorithmus, LZW, reduziert
den Speicherplatz um 20 bis 70 Prozent.

Einige Analyseprogramme bendétigen Daten von um 90 Grad
gedrehten einfarbigen Bildern. Wenn Sie die Option ,Split/
Rotate® auf ,Yes“ setzen, wird die Farbdatei in zwei Farbda-
teien geteilt und die Bilder werden um 90 Grad gedreht und
gespiegelt.

Im Folgenden wird ein Beispielbild gezeigt:

ec5 ] —>

YBCD

Die geteilten Dateien haben nun die Namen FileName_green
und FileName_red, wobei FileName fir den Namen steht,
der der Datei vor der Teilung automatisch zugewiesen
wurde.
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Wenn Sie nur einen Farbstoffkanal fiir Thre Ausgabedatei
gewahlt haben, miissen Sie diese Option auch wahlen, wenn
die Datei nur gedreht, aber nicht geteilt werden muss.

Diese Option steht nur fiir Scan-Vorginge mit einem
dynamischen 16-Bit-TIFF-Bereich zur Verfiigung.
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Erstellen/Bearbeiten von Scan-Bereichen mit dem Scan Region

Editor

Der Scan-Bereich legt den zu scan-
nenden Bereich des Objekttragers fest.
Je groRer der Bereich, desto langer die

Scan-Zeit. Faktoren wie z.B. die Posi-
tionierung und GréRe des Strichcode-
etiketts und Bereiche mit Mattglas
beeinflussen den Scan-Bereich.

Falls Sie Nicht- Agilent- Objekttriger verwenden, kénnen
Sie benutzerdefinierte Scan-Bereiche definieren oder den
Maximalbereich von 71 mm x 21,6 mm fiir einen Scan-
Bereich festlegen. Der neue Bereich wird als Auswahl in
der Scan-Tabelle und im Profile Editor angezeigt.

Starten des Scan Region Editors

Im Hauptfenster der Scan-Steuerungssoftware

¢ Wahlen Sie in der Meniileiste Tools > Scan Region Editor

(Abbildung 27).

" Arplerd Todbnslogees - Stan Hegien Editer

Bl lis

n] =t

Scanner G2505C

S (7 ) — g

m\‘y.../_

T R,
3101508

B uppdy el Do

Sean Fagon

Bl ot s ot
P2, 2350

"l

Abbildung 29 Scan Region Editor
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Im Startmenii

e Wihlen Sie in der Taskleiste Start > Programme >
Agilent Life Sciences > Scan Region Editor.

Wiahrend der Scanner in Betrieb ist, konnen Sie nicht auf
das Meniielement ,Scan Region Editor“ im Hauptfenster
zugreifen. Neue Scan-Bereiche kénnen Sie nur iber das
Startmenii erstellen und bearbeiten.

Erstellen eines neuen Scan-Bereichs mit dem Scan Region
Editor

Beim Erstellen eines neuen Scan-Bereichs oder Verwenden
von vorhandenen Scan-Bereichen miissen Sie sicherstellen,
dass der Abstand zwischen dem Scan-Bereich und dem
Strichcodeetikett mindestens 4 mm betrigt und dass der
Scan-Bereich keine anderen undurchsichtigen oder
halbtransparenten Bereiche des Objekttriagers umfasst.

1 Wahlen Sie in der Meniileiste des Scan Region Editors
File > New Region.

w. Add New Region M=] 2
Narne: ||
Ranges(mrm):
= mm 310 - 6910
W mm 1.80 - 2340
“vicith: mm 500 - 71.00
Height: [l 010 - 2160
Save | Exit |

Abbildung 30 Dialogfeld ,Add New Region”

2 Geben Sie den Namen oder die GroRe des Bereichs ein.

3 Geben Sie die Maf3e fiir den Bereich in mm gemaf3 den
unten beschrieben Kriterien ein.
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Erstellen eines neuen Scan-Bereichs mit dem Scan Region Editor

Ungiiltige Werte werden rot hervorgehoben.

X X-Achsenwert fiir die obere linke Ecke. Sie geben diesen
Wert und den fiir die Y- Achse in mm ein, um den Bereich
auf dem Objekttriger zu positionieren.

Y Y- Achsenwert fiir die obere linke Ecke.

Width Breite des Scan- Bereichs gemessen vom X- Achsenwert der
oberen linken Ecke.

Height Hohe des Scan-Bereichs gemessen vom Y- Achsenwert der
oberen linken Ecke.
Ranges Wertebereich, den Sie fiir jeden Wert eingeben konnen.
4 Klicken Sie auf Save.

Wurden keine Fehler gefunden, 6ffnet sich der Scan
Region Editor und der neue Bereich wird dort angezeigt.

# Poz [mm] | Pos [mm) | "idth [mm] | Height [mm)
Custom Fregion 1 |218 [1.95 | 70,50 |21.50

Abbildung 31 Liste der Scan-Bereiche

Show Custom Ist dieses Kontrollkidstchens aktiviert, werden nur die
regions only benutzerdefinierten Scan-Bereiche in der Liste im Scan
Region Editor angezeigt. Ist dieses Kontrollkdstchens nicht
aktiviert, enthélt die Liste auch die von Agilent bereitge-
stellten Bereiche. Diese Bereiche konnen jedoch nur mit
dem Scan Region Editor bearbeitet werden.

b SchlieRen Sie den Scan Region Editor.

Die neu erstellten Bereiche werden nun in den Scan-
Bereichslisten im Profile Editor und in der Scan-Tabelle
angezeigt.
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Bearbeiten eines vorhandenen Scan-Bereichs fiir Nicht-
Agilent-Objekttrager

Sie konnen nur die von Thnen erstellten Scan-Bereiche
bearbeiten. Die von Agilent bereitgestellten Bereiche kénnen
nicht bearbeitet oder geloscht werden.

Beim Erstellen eines neuen Scan-Bereichs oder Verwenden
von vorhandenen Scan-Bereichen miissen Sie sicherstellen,
dass der Abstand zwischen dem Scan-Bereich und dem
Strichcodeetikett mindestens 4 mm betragt.

1 Wihlen Sie im Scan Region Editor den zu bearbeitenden
Bereich aus.

2 Wahlen Sie in der Menileiste File > Open Region.

Das Dialogfeld ,Modify Region“ 6ffnet sich.

w. Modify Region

IHame I

N T
v e
width: [eo0
Height [ron

Save

mrm

mrm

mrm

mrm

d

Ranges(mm]:

310

1.80

5.00

010

- B0

- 2340
- 7010

- 21.60

Exit |

Abbildung 32 Dialogfeld ,Modify Region”

3 Andern Sie den Namen oder die GroRe des Bereichs.

4 Geben Sie die MaRe fiir den Bereich gemaf: den unter
s,Erstellen eines neuen Scan-Bereichs mit dem Scan
Region Editor“ auf Seite 69 genannten Kriterien ein.

b Klicken Sie auf Save.
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Festlegen von Zeiten zum Ein-/Ausschalten der Laser

Um die Lebensdauer der Laser zu verlingern, kénnen Sie
festlegen, dass die Laser liber das Scan- Steuerungsprogramm
automatisch ein- oder ausgeschaltet werden. Diese Funktion
ermoglicht es, dass die Laser zu einem bestimmten Zeitpunkt
bereits aufgewarmt und betriebsbereit sind oder automatisch
zu einem bestimmten Zeitpunkt oder bei Leerlauf ausge-
schaltet werden.

Unabhéngig von den Einstellungen unter ,Laser Auto ON/
OFF Settings“ haben Sie folgende Moglichkeiten:

¢ Sie konnen die Laser jederzeit manuell ein- oder
ausschalten.

¢ Wenn das Scan-Steuerungsprogramm gestartet wird,
werden die Laser eingeschaltet.

¢ Wenn ein Scanner wahrend einer definierten Ausschaltzeit
scannt, bleiben die Laser eingeschaltet.

Aktivieren der Funktion fiir das automatische Ein-/
Ausschalten der Laser

1 Wahlen Sie in der Meniileiste Tools > Laser Auto ON/
OFF Settings (Abbildung 27).

2 Doppelklicken Sie auf No, um die die Option Enable laser
auto ON/OFF auf Yes zu setzen.
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Laser Auto OH/OFF Settings

=]
Enabile Lager aubo OHOFF s

=]
O3 Turn O dady Erery day

Turn O & 700 AM
=
) Turn CFF cledly s

Turn OFF al &:00PH
B Turn OFF vl adle Tes

Tiles () 1

Tunn Lasars on Now | OF | Cance| |

Abbildung 33 Eigenschaftenseite , Laser Auto ON/OFF Settings”

Ist .NO" ausgewdhlt, miissen Sie die Laser manuell ein- und ausschalten,
wie im nachsten Abschnitt beschrieben.

Turn ON daily Wahlen Sie Weekdays only oder Weekends und geben Sie
die Zeit zum EINSCHALTEN der Laser unter der Woche
oder am Wochenende ein.

Turn OFF daily Waihlen Sie Yes und geben Sie die Zeit zum
AUSSCHALTEN der Laser unter der Woche oder am
Wochenende ein.

Turn OFF when idle Wihlen Sie Yes und geben Sie eine Zeitspanne ein, nach
der die inaktiven Laser automatisch ausgeschaltet werden.
Ist die Option No gewahlt, wird der Scanner bei dieser
Bedingung nicht ausgeschaltet.

3 Klicken Sie auf OK.
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Manuelles Ein-/Ausschalten der Laser

1 Offnen Sie die Eigenschaftenseite Laser Auto ON/OFF
Settings.

2 Klicken Sie auf Turn Lasers on Now oder Turn Lasers
off Now.

3 Klicken Sie auf OK.
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Weitere Werkzeuge

Die folgenden zusitzlichen Werkzeuge finden Sie im Menii
,Tools“.

Unlock Door

Mit dem Werkzeug zum Entriegeln der Tiur (Tools > Unlock
Door) konnen Sie versuchen, die Tir manuell zu entriegeln,
falls das Turschloss nicht ordnungsgemifd funktioniert.

Dies kann vorkommen, wenn die Abdeckung gedffnet wird,
wahrend die automatische Entriegelung des Schlosses am
Ende eines Karusselldurchlaufs noch in Betrieb ist.

Reset Calibration Warnings

Wahrend des normalen Betriebs kalibriert der Scanner
G2505C die PMTs vor jedem Scan-Vorgang und die Laser
wahrend der Systeminitialisierung bzw. nach jedem Karus-
selldurchlauf. Ist die Kalibrierung nicht erfolgreich oder
miissen bei der Kalibrierung erhebliche Anderungen im Ver-
gleich zum letzten Durchgang vorgenommen werden, erfasst
die Scannersoftware dies und erzeugt Warnhinweise im
Karussellprotokoll.

Warnhinweise zur PMT- Kalibrierung werden ausgegeben,
wenn sich die PMT-Spannung um mehr als 20% im Vergleich
zum letzten Kalibrierungswert dndert.

Warnhinweise zur Laserkalibrierung werden ausgegeben,
wenn die Laser wahrend der Aufwarmphase nicht die ange-
gebene Leistung erreichen. Ist dies der Fall, wird automa-
tisch ein Warnhinweis angezeigt und die Laser werden auf
80% ihrer angegebenen Leistung neu kalibriert. Das Scan-
Steuerungsprogramm skaliert die TIFF-Datei so, dass die
niedrigere Laserleistung kompensiert wird.

Sie konnen diese Warnhinweise zuriicksetzen, indem Sie
Tools > Reset Calibration Warnings wihlen.
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Ist die néichste Kalibrierung auch nicht erfolgreich und
werden die Warnungen erneut angezeigt, sollten Sie sich an
Thr Agilent Vertriebs- und Supportcenter wenden.

Extended Laser Calibration

Waihrend der normalen Kalibrierung der Laser wird nicht
die maximale Leistung ermittelt. Mit dem Werkzeug fiir eine
erweiterte Laserkalibrierung kann eine umfangreichere Prii-
fung des Lasersubsystems durchgefiihrt werden. Wenn Sie
wiederholt Warnhinweise zur Laserkalibrierung erhalten,
kann das Agilent Supportteam Sie dazu auffordern, das
Werkzeug fiir eine erweiterte Laserkalibrierung zu verwen-
den und anschlielend die Log-Dateien mit den Ergebnissen
per E-Mail zu schicken.
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Wartung lhres Systems

Mit der richtigen Pflege und Wartung koénnen Sie Thren
Microarray- Scanner ohne Komplikationen verwenden.
Wenden Sie sich bei Fragen zur Verwendung oder Pflege
des Microarray-Scanners an Ihr Agilent Vertriebs- und
Supportcenter.

RegelmidBige In diesen Abschnitten werden die Wartungsaufgaben fiir
Wartungsaufgaben die Software und Hardware beschrieben, die regelméiRig
ausgefiihrt werden miissen, um einen effizienten Betrieb

des Microarray-Scanners sicherzustellen.

Tipps zur Vermeidung In diesem Abschnitt erhalten Sie Hinweise zum Betrieb
von Problemen und zur Pflege des Microarray-Scanners, um Probleme zu
vermeiden.

RegelmaRige Softwarewartung

Die Ausfithrung dieser Aufgaben tragt zur Sicherstellung
der Leistung Ihres PC- Arbeitsplatzes und MS Windows-
Betriebssystems bei:

¢ Priifen Sie mindestens einmal die Woche den
Plattenspeicherplatz und archivieren Sie ggf. Daten.

¢ Loschen Sie einmal die Woche temporire Dateien (*.mp-,
*tmp-Dateien) aus dem Ordner C:\Temp.

¢ Wenn Sie eine niedrige Leistung beobachten, defragmen-
tieren Sie die Festplatte mit der Defragmentierungssoft-
ware.
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RegelmiaRige Hardwarewartung

Die Ausfithrung dieser Aufgaben tragt zur Sicherstellung der
Leistung Ihres Microarray-Scanners bei.

Uberpriifen der Liiftung und des Luftfilters

Eine hinreichende Beliftung im Microarray-Scanner ist fiir
einen ordnungsgemifien Betrieb unerlidsslich. Verstopfte
Liftungen und dreckige Luftfilter konnen die Leistung
nachhaltig beeintrachtigen.

Liftung Liftungen miissen einmal wochentlich tiberpriift
werden, um sicherzustellen, dass sie nicht durch Staub,
Fremdkoérper, Mobel oder sonstige Gerdte blockiert werden.

Luftfilter Der Luftfilter im Microarray-Scanner sollte wie
folgt einmal monatlich auf Schmutz gepriift werden:

1 Schalten Sie den Microarray-Scanner aus.

2 Offnen und entfernen Sie an der rechten Seite des
Microarray- Scanners die Luftfilterabdeckung.

Abnehmbare
Luftfilter-
abdeckung

Abbildung 34 Offnen und Abnehmen der Luftfilterabdeckung

3 Entfernen Sie den Luftfilter aus dem Tiirgehduse und
fithren Sie eine Sichtpriifung des Luftfilters durch.
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Luftfilter

Luftfilterabdeckung

Abbildung 35 Entfernen des Luftfilters

Reinigen des Luftfilters

Hat sich Schmutz angesammelt oder sind seit der letzten
Reinigung sechs Monate vergangen, sollten Sie den Luftfilter
reinigen.

1
2

Waschen Sie den Luftfilter mit warmem Wasser.
Driicken Sie das Wasser aus dem Luftfilter.

Das Wasser sollte komplett aus dem Luftfilter
herausgepresst werden.

Lassen Sie den Luftfilter vollstindig trocknen, bevor Sie
ihn einbauen. Sie konnen den Filter mit Papiertiichern
trocken tupfen.

Bauen Sie den Luftfilter wieder in das Gehause der
Luftfilterabdeckung ein und schliefen Sie die Abdeckung.

Uberpriifen Sie, ob der Luftfilter nach dem Trocknen
wieder eingesetzt wurde. Wurde der Luftfilter nicht
wieder eingebaut, kann sich Staub im Gerat bilden und
so die Leistung nachhaltig beeintrachtigen.

Luftfilter (Teilenr. 3150-0956) konnen direkt bei Ihrem
Agilent Vertriebs- und Supportcenter bestellt werden.
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Tipps zur Vermeidung von Problemen

Fiithren Sie die zuvor beschriebenen regelméifdigen
Wartungsaufgaben durch und befolgen Sie diese Tipps, um
den Microarray-Scanner und seine Leistung zu warten.

Tipps zur Vermeidung von Datenverlust

* Vermeiden Sie das Laden von Softwareprogrammen,
die eine hohe CPU- Arbeitslast erzeugen, da dies die
Datenerfassung wihrend des Scan-Vorgangs
beeintrachtigen kann.

Tipps zur Vermeidung von Schaden am Scanner

¢ Halten Sie Flissigkeiten und Diampfe vom Microarray-
Scanner fern.

¢ Minimieren und tiberwachen Sie Temperatur-
schwankungen.

Setzen Sie den Microarray-Scanner nicht direkter
Sonneneinstrahlung aus. Stellen Sie den Microarray-
Scanner nicht in der Ndhe von Fenstern auf, auch wenn
diese iiber Jalousien oder sonstigen Sichtschutz verfiigen.
Durch direkte Sonneneinstrahlung kann sich das Gehause
des Microarray- Scanners ungleichmifig erhitzen, wodurch
Probleme bei der Ausrichtung der optischen Komponenten
auftreten koénnen.

Fithren Sie Scan-Vorgiange nur aus, wenn die Labortempe-
ratur den Spezifikationen zur Betriebstemperatur fiir den
Microarray- Scanner entspricht. Um eine optimale Micro-
array- Scannerleistung sicherzustellen, nehmen Sie den
Scanner nur in Betrieb, wenn die angegebenen Tempera-
turbereiche eingehalten werden. (Siehe ,Microarray-Scan-
nerspezifikationen“ auf Seite 108.)

o Uberwachen Sie die Luftfeuchtigkeit.

Der Microarray-Scanner kann empfindlich auf kondensie-
rende Luftfeuchtigkeit reagieren. Um eine optimale Micro-
array- Scannerleistung sicherzustellen, nehmen Sie den
Scanner nur in Betrieb, wenn die angegebenen Luftfeuch-
tigkeitsbereiche eingehalten werden. (Siehe ,Microarray-
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Scannerspezifikationen“ auf Seite 108.) Vor dem Offnen
der Verpackung ist eine 10-stiindige Temperaturanpassung
vor Ort erforderlich.

Tipps zur Wartung der Hardwareleistung

¢ Vermeiden Sie es, den Microarray-Scanner umzustellen.

Wenn der Microarray-Scanner umgestellt werden muss,
kann seine Leistung nachhaltig beeintrichtigt werden.
Hilfreiche Informationen zum Umstellen des Microarray-
Scanners erhalten Sie von Threm Agilent Vertriebs- und
Supportcenter.

e Stellen Sie den Microarray-Scanner auf einen stabilen
Labortisch.

¢ Vermeiden Sie es, sich auf den Microarray-Scanner zu
stutzen.

e Um die Lebensdauer der Laser zu verlingern, kdnnen
Sie festlegen, dass die Laser automatisch ein- und
ausgeschaltet werden. Siehe ,Festlegen von Zeiten zum
Ein- /Ausschalten der Laser“ auf Seite 72 in Kapitel 4.

* Geben Sie dem Laser nach dem Einschalten die
Moglichkeit zum Aufwirmen und Stabilisieren. Die
maximale Aufwirmphase betriagt 30 Minuten.

¢ Halten Sie den Karussellboden mit einem Lappen und
ohne Loésungsmittel sauber.

¢ Verwenden Sie kein Aceton oder sonstige Losungsmittel
zum Reinigen.

¢ Kommen Sie nicht mit dem Getriebe beim Karussell in
Beriihrung.

m Entfernen Sie die Abdeckungen nicht. Versuchen Sie nicht, die
internen Komponenten zu reparieren oder auf diese zuzugreifen.
Andernfalls kdnnten Sie sich selbst Hochspannung und gefahrlicher
Laserstrahlung aussetzen.
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Fehlerbehebung in lhrem System

Der Agilent Microarray-Scanner ist auf geringe Wartungs-
anforderungen und hohe Benutzerfreundlichkeit ausgerichtet.
Wenn Sie ein Systemproblem nicht 16sen kénnen, lesen Sie
bitte dieses Kapitel vollstindig durch, bevor Sie sich an Ihr
Agilent Vertriebs- und Supportcenter wenden.

Technischer Support In diesem Kapitel erhalten Sie wichtige Informationen zum
technischen Support.

Haufig gestellte  Dieser Abschnitt enthilt Antworten auf hiaufig gestellte
Fragen Fragen zu Support und Wartung.

Fehlerbehebung bei der Hier wird die Statusanzeige beschrieben und wie Sie die
Hardware Sicherungen austauschen.

Fehlerbehebung Hier werden die Sicherheitsvorkehrungen beschrieben,
bei der die getroffen werden miissen, wenn Software und Daten
Software  auf Threr Festplatte mit der Wiederherstellungs- CD
wiederhergestellt werden sollen.

Scannerfehlerm  Hier erfahren Sie mehr tber wichtige Fehlermeldungen und
eldungen Losungen.
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Technischer Support

Fir das Agilent Microarray- Scannersystem steht technischer
Support zur Verfiigung. Lesen Sie sich das Kapitel durch,
bevor Sie sich an Ihr Agilent Vertriebs- und Supportcenter
wenden.

Technischer Support iiber das Internet

Uber eine mit der Software gelieferte Standard- URL kénnen
Sie den technischen Agilent Support fiir den Microarray-
Scanner kontaktieren.

e Klicken Sie auf Help > Technical Support.

Support fiir den PC-Arbeitsplatz

Weitere Informationen zu Problemen mit dem PC-
Arbeitsplatz finden Sie in der mit dem PC gelieferten
Dokumentation.

Wenn Sie das Problem dennoch nicht 16sen kénnen, wenden
Sie sich an Thr Agilent Vertriebs- und Supportcenter oder
klicken Sie auf Help > Technical Support.

Microarray-Scannersupport

Wenn Sie ein Problem mit IThrem Microarray-Scanner haben,
fiir das Unterstiitzung von Threm Agilent Vertriebs- und
Supportcenter erforderlich ist, kbnnen Sie dazu aufgefordert
werden, die letzte vom Scan- Steuerungsprogramm erstellte
Diagnose- Log-Datei bereitzustellen. Diese Dateien befinden
sich im Ordner C:\Programme\Agilent\Microarray\Logs.

Zusatzliche Diagnoseinformationen, einschlief3lich der
Ergebnisse des Selbsttests, konnen mit dem HyperTerminal-
Programm erfasst werden. Weitere Informationen zum
Einrichten und Verwenden dieses Kommunikationswerkzeugs
erhalten Sie unter ,Verwenden von HyperTerminal zur
Erfassung von Diagnosedaten“ auf Seite 93.
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Jeder Agilent Microarray-Scanner verfiigt iber eine
eindeutige 10-stellige Seriennummer. Die Seriennummer
befindet sich auf zwei Aufklebern auf dem Microarray-
Scanner: am Karussellgestell und hinter der Filterabdeckung.

Geben Sie in der Korrespondenz mit Threm Agilent
Vertriebs- und Supportcenter immer die Modellnummer und
10- stellige Seriennummer an.

Notieren Sie sich die Seriennummer Thres Agilent Microar-
ray- Scanners, die Softwareversionsnummer und das Installa-
tionsdatum in den dafiir vorgesehen Feldern (wenn Sie diese
Seite drucken) oder auf einem Blatt Papier, das Sie in der
Nahe Thres Scanners aufbewahren.

Scannerinformationen

Modellnr.:

Seriennr.:

Installationsdatum:

Softwareversionsnr.:

Versionsnr./Datum von Softwareupdates:

Versionsnr./Datum von Softwareupdates:

Suche nach Versionsinformationen fiir die Scannersoftware

1 Wahlen Sie in der Meniileiste Help > About, um nach
Versionsinformationen zu suchen.

2 Klicken Sie zum SchlieRen des Programms auf OK.
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Haufig gestellte Fragen (FAQs)

Tabelle 2 FAQs

Im Folgenden werden haufig gestellte Fragen (FAQs) und
die entsprechenden Antworten aufgefiihrt, die Thnen
beim Betrieb und der Wartung des Agilent Microarray-
Scannersystems sowie bei der Behebung von moglichen
Fehlern als Hilfe dienen koénnen.

FAQ

Antwort

Ich mochte den Microarray-Scanner
umstellen.

Kann ich Dateien wahrend des
Scannens (ber das Netzwerk sichern?

Wo finde ich Supportinformationen fiir
meinen PC-Arbeitsplatz, wie z.B. Treiber,
Handbiicher und Lésungen zur
Fehlerbehebung?

Ich kann die obere Abdeckung des
Karussells nicht 6ffnen.

Die Scannerleistung kénnte dadurch nachhaltig beeintrachtigt werden.
Hilfreiche Informationen zum Umstellen und zur Sicherstellung des
ordnungsgemaRen Betriebs des Microarray-Scanners erhalten Sie von [hrem
Agilent Vertriebs- und Supportcenter.

Agilent empfiehlt, dass Sie Ihre Datendateien direkt auf die lokale Festplatte
speichern. Dariiber hinaus koénnen sie auf einem Netzwerkverzeichnis
gespeichert werden. Wird wéahrend des Scannens ein Problem beim
Netzwerkzugriff festgestellt, werden die Daten in einem temporaren lokalen
Verzeichnis gespeichert und ein Warnhinweis wird im Karussellprotokoll
angezeigt.

Weitere Informationen zu Problemen mit dem PC-Arbeitsplatz finden Sie in der
mit dem PC gelieferten Dokumentation. Wenn Sie das Problem dennoch nicht
I6sen kénnen, wenden Sie sich an lhr Agilent Vertriebs- und Supportcenter.

Versuchen Sie nicht, die Abdeckung mit Gewalt zu 6ffnen. Das gewaltsame
Offnen der Abdeckung kann den Microarray-Scanner beschadigen.

1 Driicken Sie die Abdeckung nach unten, um die ggf. vorhandene
Federspannung zu verringern, und versuchen Sie anschlieend, die
Abdeckung zu 6ffnen. Wenn dies nicht gelingen sollte, fahren Sie mit Schritt
2 fort.

2 SchlieRen Sie das Scan-Steuerungsprogramm und starten Sie es neu.

Versuchen Sie, die Abdeckung zu 6ffnen.

4 Lasst sich die Abdeckung weiterhin nicht 6ffnen, schlieRen Sie das Scan-
Steuerungsprogramm und schalten Sie den Microarray-Scanner aus.
Schalten Sie den Microarray-Scanner anschlieRend wieder ein.

5 Versuchen Sie, die Abdeckung zu 6ffnen.

6 Léasstsich die Abdeckung immer noch 6ffnen, wenden Sie sich an Ihr Agilent
Vertriebs- und Supportcenter.

w
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Tabelle 2 FAQs (Fortsetzung)
FAQ Antwort
Das Scan-Steuerungsprogramm reagiert Das Scan-Steuerungsprogramm reagiert nicht mehr — die Statusmeldung ist seit
nicht. mehr als 15 Minuten unverandert und Sie kénnen das Programm nicht
schlieBen. Fithren Sie folgende Schritte aus:
1 Offnen Sie den Windows Task-Manager (Strg-Alt-Entf) und schlieRen Sie das
Scan-Steuerungsprogramm. Starten Sie anschlieRend das Scan-
Steuerungsprogramm neu.
Schlégt dieser Schritt fehl, starten Sie den PC-Arbeitsplatz neu, schalten Sie
den Microarray-Scanner aus und wieder ein, warten Sie, bis die gelbe
Statusanzeige nicht mehr leuchtet, und starten Sie das Scan-
Steuerungsprogramm erneut.
Was mache ich, wenn ein Objekttrager Driicken oder ziehen Sie (je nachdem, wobei es weniger Widerstand gibt)
vom Arm zum automatischen Beladen den Arm vorsichtig bis zum Ende seiner Reichweite. Uben Sie dabei keine
des Karussells nicht ordnungsgeméaR Gewalt aus.
eingesetzt wird? SchlieRen Sie das Scan-Steuerungsprogramm und starten Sie es neu.
Besteht das Problem weiterhin, wenden Sie sich an lhr Agilent Vertriebs-
und Supportcenter.
Der Microarray-Scanner ist Priifen Sie, ob der PC-Arbeitsplatz eingeschaltet ist.
eingeschaltet, aber die gelbe Anzeige Priifen Sie, ob das USB-Kabel mit dem PC-Arbeitsplatz und dem Microarray-
leuchtet nach 20 Minuten noch. Scanner verbunden ist.
Wenden Sie sich an Ihr Agilent Vertriebs- und Supportcenter.
Der Microarray-Scanner ist SchlieRBen Sie das Scan-Steuerungsprogramm und starten Sie es neu.
eingeschaltet und das Scan- Der Microarray-Scanner muss eingeschaltet sein, bevor das Scan-Steue-
Steuerungsprogramm ist gedffnet, rungsprogramm gestartet wird. Wenn Sie das Scan-Steuerungsprogramm
aber der Scanner scannt nicht. zuerst starten, wird beim Einschalten des Scanners keine Verbindung herge-
stellt.
Wenden Sie sich an Ihr Agilent Vertriebs- und Supportcenter.
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Fehlerbehebung bei der Hardware

Es gibt nur wenige Teile beim Microarray-Scanner, die Sie
selbst warten kénnen. Sie konnen Maf3inahmen zur Behebung
von Fehlern ergreifen, auf die durch die Statusanzeige an
der Vorderseite hingewiesen wird. Auf3erdem kénnen Sie die
Sicherungen austauschen, die das System schiitzen. Bei
anderen Problemen einschliefllich Stau sollten Sie sich an
Ihr Agilent Vertriebs- und Supportcenter wenden.

Weitere Informationen zu Problemen mit dem PC-
Arbeitsplatz finden Sie unter ,Support fiir den PC-
Arbeitsplatz® auf Seite 84.

Fehlerbehebung mit der Statusanzeige

Auf der Vorderseite befinden sich drei Leuchten fiir die
Statusanzeige, die den aktuellen Status des Microarray-
Scanners anzeigen.

S

\}éﬁy ", E o
Status- | 1T .ﬁ
anzeige :

[ o

Abbildung 36 Statusanzeige

Tabelle 3 beschreibt die Mafnahmen, die bei der
entsprechenden Statusanzeige durchgefithrt werden miissen.

Agilent Microarray-Scannersystem G2565CA (Scan-Steuerungssoftware 8.4) — Benutzerhandbuch



Tabelle 3 Anzeigestatus

Wartung und Fehlerbehebung im System b

LED-Status Magliche Empfohlene
Ursachen MaRnahme
Griin Gelb Rot
Aus Aus Aus Keine Stromversorgung des  Uberpriifen Sie Folgendes:
Scanners. * Ob der Ein-/Aus-Schalter
eingeschaltet ist
* 0b das Stromkabel
angeschlossenistund ob an der
Steckdose Spannung anliegt
* dass die Sicherungen nicht
durchgebrannt sind
Einmaliges Blinken ~ Einmaliges Einmaliges LED-Test beim Einschalten ~ Keine MaRnahme erforderlich.
Blinken Blinken (Dauer < 1 Sek.)
Blinken Blinken Aus Selbsttest beim Einschalten  Keine MaRnahme erforderlich.
wird ausgefiihrt Verwenden Sie HyperTerminal, um
Diagnoseinformationen zu
erfassen. Siehe ,,Verwenden von
HyperTerminal zur Erfassung von
Diagnosedaten” auf Seite 93.
Aus Blinken Aus Verbindungsversuch zum Installieren Sie die Scan-
(20 Sek. aus/ PC Steuerungssoftware 8.0, falls sie
20 Sek. an) noch nicht installiert ist.
Aus oder an Blinken Aus Herunterladen der Firmware Keine MaRnahme erforderlich.
(Dauer=1,3 und DSP-Initialisierung
oder 1,0 Sek.)
An An Aus Die Laser befinden sich in Warten Sie. Die maximale
der Aufwarmphase und sind  Aufwérmphase betragt 30 Minuten.
noch nicht betriebsbereit.
An Aus Aus Das Gerat ist bereit fir den  Keine MaRnahme erforderlich.
Scan-Vorgang.
Blinken Aus Aus Scan-Vorgang Keine MaRnahme erforderlich.
Beliebiger Status Beliebiger An Fehler ermittelt. Wenden Sie sich an Ihr Agilent
Status Vertriebs- und Supportcenter.
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Uberpriifen und Austauschen der Scannersicherungen

Der Microarray-Scanner verfiigt iiber drei Sicherungen, zwei
Sicherungen fir das Netzteil und eine Sicherung fiir den
roten Laser. Die Sicherungen befinden sich an der Riickseite
des Microarray-Scanners. Die Sicherungen fiir das Netzteil
befinden sich direkt tiber dem Netzstecker. Die Lasersiche-
rung befindet sich in einem runden Sicherungshalter links
neben dem Netzstecker.

Die Sicherungen konnen direkt bei Agilent Technologies
bestellt werden.

Ziehen Sie das Stromkabel immer ab, bevor Sie die Sicherungen
itberpriifen oder austauschen.

Uberpriifen und Austauschen der Netzsicherungen Kann der
Microarray- Scanner nicht eingeschaltet werden, obwohl
Spannung an der Steckdose nachgewiesen wurde, sollten Sie
die Sicherungen tuberpriifen und ggf. austauschen. Dies
geschieht von der Riickseite des Gerits.

1 Ziehen Sie das Stromkabel ab.

2 Heben Sie mit einem kleinen Schlitzschraubendreher die
kleine Plastiknase an der unteren Kante des Sicherungs-
halters an, bis sie entriegelt ist.

3 Nehmen Sie den Sicherungshalter heraus und uberpriifen
Sie, ob die Sicherungen intakt sind.

4 Ist eine Sicherung durchgebrannt, tauschen Sie diese mit
einer Sicherung vom Typ T4A, 250 V Wechselstrom aus
(Teilenr. 2110-1309).

b Driicken Sie den Sicherungshalter zuriick, bis er einrastet.

6 SchlieRen Sie das Stromkabel an.

Als Ersatz dirfen nur Sicherungen vom selben Typ oder mit gleichem
Nennstromwert verwendet werden. Sind Sie sich bei den Sicherungen
nicht sicher, wenden Sie sich vor dem Einbau an Ihr Agilent Vertriebs-
und Supportcenter.
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~~——__ Netzsicherungs-
halter

Abbildung 37 Entfernen des Sicherungshalters fiir das Netzteil

Uberpriifen und Austauschen der Sicherung fiir den roten Laser

Kann der Microarray-Scanner eingeschaltet werden, aber
ist der rote Laser weiterhin ausgeschaltet, konnen Sie die
Lasersicherung an der Riickseite des Gerits problemlos
uberpriifen und austauschen.

1 Ziehen Sie das Stromkabel ab.

2 Losen Sie mit einem kleinen Schlitzschraubendreher die
Schrauben der runden Kappe, bis sie sich abnehmen lisst.
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Lasersicherungs-
halter

Abbildung 38 Lasersicherungshalter

3 Nehmen Sie den Sicherungshalter heraus und tberpriifen
Sie, ob die Sicherungen intakt sind.

4 Ist eine Sicherung durchgebrannt, tauschen Sie diese mit
einer Sicherung vom Typ T500mA, 250 V Wechselstrom
aus (Teilenr. 2110-0458).

b Bauen Sie den Sicherungshalter wieder ein und schrauben
Sie die Kappe an.

Fehlerbehebung, wenn sich der Arm zum automatischen Beladen
ither dem Karussell befindet

1 Schalten Sie den Scanner aus.

2 Drehen Sie das Karussell und driicken Sie den Arm in die
richtige Position.

Sollte dies nicht funktionieren, wenden Sie sich an Ihr
Agilent Vertriebs- und Supportcenter.

Wenn Sie das Karussell herausnehmen, wahrend sich der Arm zum
automatischen Beladen des Karussells iiber dem Karussell befindet,
kann dies zu schweren Beschadigungen am Microarray-Scanner
fuhren.

Agilent Microarray-Scannersystem G2565CA (Scan-Steuerungssoftware 8.4) — Benutzerhandbuch



Wartung und Fehlerbehebung im System b

Verwenden von HyperTerminal zur Erfassung von
Diagnosedaten

Durch das Einrichten einer HyperTerminal- Sitzung konnen
die Agilent Servicemitarbeiter und Benutzer Daten zur
Fehlerbehebung am Scanner erfassen. Die nachfolgenden
Anweisungen beziehen sich auf Windows XP-Systeme.
Anweisungen zum Erfassen von Diagnosedaten fiir Scanner
mit Windows Vista 32-Systemen erhalten Sie in den Ver-
sionshinweisen zur Scan-Steuerungssoftware 8.4.

Einrichten von HyperTerminal

1 Schalten Sie den Scanner zum Starten der Initialisierung
ein.

2 Starten Sie das Scan-Steuerungsprogramm, um die Laser

einzuschalten.

3 Stellen Sie sicher, dass der Scanner mindestens
30 Sekunden eingeschaltet ist, bevor Sie HyperTerminal
starten (Schritt 4).

4 Klicken Sie auf Start > Programme > Zubehor >
Kommunikation > HyperTerminal.

b Im Dialogfeld ,Beschreibung der Verbindung“:

a Geben Sie Scanner im Textfeld Name ein.

Conmeclion Descriplion

% Hew Connachion

Erder & name and choone an icon for the connechion

Hame

Seanme

[ ox ][ canes |

b Klicken Sie auf OK.
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Wihrend der Scanner eingeschaltet ist und HyperTerminal ausgefiihrt
wird, kann der Scanner keine Initialisierung durchfiihren. Sie diirfen
HyperTerminal erst 30 Sekunden nach dem Einschalten des Scanners
starten.

6 Im Dialogfeld ,Verbinden mit“:

a Waihlen Sie in der Dropdownliste Verbindung
herstellen iiber die héchste COMX-Zahl aus.

Dies ist normalerweise COM3 und kann im Windows
Gerate- Manager gepriift werden. Der COM- Anschluss
fir den Scanner wird als ,Serieller USB- Anschluss
(COMX)“ aufgefiihrt.

Erben dhesliads lod The phone nanbss hat vou wesl Lo dal

Cowmipiraguon:
Hana code:

Phone number:

Connect using b
[iH [ roncel |

b Klicken Sie auf OK.

7 Im Dialogfeld ,Eigenschaften von COMX*“:
a Wahlen Sie 19200 fiir Bits pro Sekunde.

b Wihlen Sie Kein fiir Flusssteuerung.
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COM3 Properties FIE=

Pod Settngi
Bty pem econd: | 19200 w
Daes b |8 w
Faely | Mans ‘f
Slog b | 1 £

Flow corict | IR

| Riestors Delods

[ or [ cemes ][ eow |

¢ Klicken Sie auf OK.
Das Fenster ,Scanner - HyperTerminal® wird angezeigt.

8 Klicken Sie auf Datei > Speichern, um die Datei unter
Scanner.ht zu speichern, und schlieRen Sie das Fenster.

9 Klicken Sie auf Ja, wenn Sie gefragt werden, ob Sie die
bestehende Verbindung beenden mdchten.

10 Erstellen Sie eine Verknipfung mit dem Namen
Scanner.ht auf dem Desktop:

a Klicken Sie auf Start > Programme > Zubehor >
Kommunikation.

b Klicken Sie im HyperTerminal- Untermenii mit der
rechten Maustaste auf Scanner.ht.

Beachten Sie, dass ein HyperTerminal- Untermenii im
Menii ,Kommunikation“ hinzugefiigt wurde. Klicken Sie
nicht mit der rechten Maustaste auf das HyperTerminal-
Programmsymbol im oberen Teil des Meniis.

¢ Klicken Sie im Kontextmenii auf Verkniipfung
erstellen.

d Klicken Sie auf Verkniipfung mit Scanner.ht und
ziehen Sie die Option auf den Desktop.

Agilent Microarray-Scannersystem G2565CA (Scan-Steuerungssoftware 8.4) — Benutzerhandbuch 95



5  Wartung und Fehlerbehebung im System

11 Starten Sie eine HyperTerminal-Sitzung zum Aufzeichnen
von Text:

a Doppelklicken Sie auf das Symbol Scanner.ht auf dem
Desktop.

b Klicken Sie auf Ubertragung > Text aufzeichnen.
¢ Klicken Sie auf Durchsuchen.

d Suchen Sie im Dialogfeld Datei zum Aufzeichnen
auswahlen nach dem Laufwerk E:\.

e Erstellen Sie einen neuen Ordner mit dem Namen
Support.

f Erstellen Sie im Ordner Support einen neuen Ordner
und nennen Sie ihn HyperTerminal Capture Files.

g Geben Sie im Ordner HyperTerminal Capture Files
den Dateinamen Capture yymmdd-# im Textfeld
Dateiname ein, wobei yymmdd fir das heutige Datum
und # fiir die Nummer der Aufzeichnungssitzung fiir
diesen Tag steht.

h Klicken Sie auf Speichern.

i Klicken Sie im Dialogfeld ,Text aufzeichnen“ auf

Starten.

1
Frdcde C \Documenty ared Sefings\dand_baon My
Ei= Jorsal Captuee P \Lspnre 0501 051, T M

Stat I Carcel |

Die HyperTerminal-Daten werden an diese Datei angehingt,
bis HyperTerminal geschlossen wird oder die Sitzung Text
aufzeichnen... iiber das Dropdownmenii Ubertragung
beendet wird.

HyperTerminal wird geschlossen, wenn Sie sich abmelden.
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Starten einer HyperTerminal-Aufzeichnungssitzung nach
erstmaliger Einrichtung

Sind die Laser bereits aufgewirmt, fahren Sie mit Schritt 3
fort.

1 Schalten Sie den Scanner zum Starten der Initialisierung
ein.

2 Starten Sie das Scan- Steuerungsprogramm, um die
Aufwarmphase fiir die Laser zu starten.

3 Doppelklicken Sie auf das Desktopsymbol Scanner.ht.

4 Klicken Sie im HyperTerminal- Dropdownmenii
Ubertragung auf Text aufzeichnen.

b Im Dialogfeld Text aufzeichnen

a Andern Sie den Dateinamen im Textfeld Datei, sodass
dieser das heutige Datum und die Aufzeichnungssitzung
enthalt.

b Klicken Sie auf Starten.

2
Frdcde C \Documenty ared Sefings\dand_baon My
Ei= |l Captuee Fiet\Dapnre |y’.‘1ﬂ Tt M
Stat I Carcel |

Sie kénnen auch auf ,Durchsuchen® klicken, um das Dia-
logfeld ,Datei zum Aufzeichnen auswihlen“ zu 6ffnen.
Wahlen Sie im Dialogfeld ,Datei zum Aufzeichnen auswéih-
len“ einen neuen Ordner oder einen neuen Dateinamen.
Andernfalls wird die urspriingliche Datei der Aufzeich-
nungssitzung tiberschrieben. Klicken Sie anschliefend auf
Speichern, um fortzufahren.
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Fehlerbehebung bei der Software

Falls Ihr PC abstiirzt oder Sie das von Agilent mit dem PC
gelieferte Image der Festplatte neu laden mochten, finden
Sie im Lieferumfang von Agilent eine Wiederherstellungs- CD,
mit der Sie die Festplatte erneut abbilden kénnen.

Um diese CD erfolgreich zu verwenden, miissen Sie das
USB-Kabel an der Riickseite des PCs abziehen, bevor Sie die
CD benutzen.

Wenn Sie das Kabel nicht abziehen, kénnen die Agilent Standard-
einstellungen fir die USB-Gerate verandert werden und die Software
erkennt beim Neustart der Software den Scanner nicht.
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Microarray-Scannerfehlermeldungen

In diesem Abschnitt wird erldutert, wie Sie mit moglichen
Fehlermeldungen umgehen.

Quellen von Fehlermeldungen

Der PC-Monitor zeigt Fehlermeldungen fiir die Microarray-
Scannerhardware, die Scan-Steuerungs- und Merkmals-
extraktionssoftware, Microsoft Windows und den PC- Arbeits-
platz an. Lesen Sie die Titelleiste der Fehlermeldung, um die
Quelle der Fehlermeldung zu ermitteln.

Die Titelleiste der Fehlermeldung weist darauf hin,

dass sich diese Meldung auf die Karussellhardware
bezieht.

Urowsing carousel ll

Q Drecrigplion: The chip caroussl & nol present. Pleacs place Uhe carouss] in e scanrer and ey Sg80,

[ |

Abbildung 39 Titelleiste einer Scan-Steuerungsfehlermeldung

Hier werden die Fehlermeldungen fiir die Microarray-
Scannerhardware und das Scan-Steuerungsprogramm
beschrieben.

Falls die Titelleiste anzeigt, dass ein Problem mit dem PC-
Arbeitsplatz oder Windows besteht, finden Sie weitere
Informationen hierzu unter ,Support fiir den PC-
Arbeitsplatz® auf Seite 84.

Wo Scannerfehlermeldungen angezeigt werden

Fehlermeldungen koénnen an folgenden Stellen angezeigt
werden:

¢ Fehler bei der Microarray-Scannerinitialisierung werden
in der Meldung Scanner status im Fenster des Scan-
Steuerungsprogramms angezeigt. Siehe ,Schritt 4. Scannen
der Objekttrager” auf Seite 36 in Kapitel 2.
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¢ Fehler vor dem Start des Scanners werden tiiber
Meldungsfelder ausgegeben.

¢ Einige Fehler beim Scan-Vorgang werden in der Meldung
Status im Dialogfeld ,Scan Progress“ angezeigt.

¢ Fehlermeldungen werden wihrend des Karusselldurchlaufs
im Karussellprotokoll erfasst. Siehe ,Anzeigen des
Karussellprotokolls wahrend eines Durchlaufs“ auf
Seite 46 in Kapitel 2.

Wir empfehlen, dass Sie das Protokoll zumindest

nach dem ersten Scan-Vorgang und nach Abschluss
des Karusselldurchlaufs tiberpriifen. Das Protokoll wird
automatisch am Ende eines Karusselldurchlaufs erstellt.

Fehlerbehebung bei Fehlermeldungen

Das Agilent Microarray-Scannersystem erzeugt Fehlermel-
dungen, um Sie bei der Behebung méglicher Probleme zu
unterstiitzen. Viele der Fehlermeldungen bieten eine Losung
im Textfeld an; befolgen Sie die Anweisungen.

Die folgende Tabelle fiihrt einige der Fehlermeldungen auf,
die ohne Anweisungen angezeigt werden. Die Beschreibungen
enthalten Informationen, die Thnen bei der Lésung des
Problems helfen konnen.
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Wartung und Fehlerbehebung im System b

Fehlermeldung

Beschreibung oder Losung

Application Is Already Running

Autofocus error: Did not detect two
reflective surfaces during home.

Autofocus error. No PSD signal is
detected. Make sure there is a slide in
the chip holder.

Autofocus was unable to retain focus as

it travelled to the scan start position.

Cannot eject chip. There is already a chip
in the slot.

Es konnen nicht zwei Kopien des Scan-Steuerungsprogramms gleichzeitig
ausgefihrt werden.

Fihren Sie folgende Schritte aus:

1 Prifen Sie, ob der Objekttrager ordnungsgemaR in den Halter eingesetzt
wurde. Siehe , Schritt 2. Einlegen der Objekttréger in die Halter” auf Seite 26
oder versuchen Sie es mit einem anderen Objekttragerhalter.

2 Uberpriifen Sie, ob der Objekttrager den Agilent Spezifikationen entspricht.
Siehe ,,Objekttragerspezifikationen” auf Seite 111.

3 Besteht das Problem fiir diesen Objekttrager weiterhin, ist vielleicht etwas
mit dem Objekttrager nicht in Ordnung.

4 Wahlen oder erzeugen Sie ggf. einen geeigneten Scan-Bereich. Bei einigen
Nicht-Agilent-Objekttragern mit halbtransparenten oder undurchsichtigen
Umrandungen kann es sein, dass der Scan-Bereich zu nahe am
undurchsichtigen Bereich des Glases liegt. Siehe ,Erstellen eines neuen
Scan-Bereichs mit dem Scan Region Editor” auf Seite 69.

5 Wenden Sie sich an lhr Agilent Vertriebs- und Supportcenter.

Fihren Sie folgende Schritte aus:

1 Prifen Sie, ob der Objekttrager ordnungsgemaR in den Halter eingesetzt
wurde. Siehe , Schritt 2. Einlegen der Objekttrager in die Halter” auf Seite 26.

2 Uberpriifen Sie, ob der Objekttrager den Agilent Spezifikationen entspricht.
Siehe ,,Objekttragerspezifikationen” auf Seite 111.

3 Besteht das Problem fiir diesen Objekttrager weiterhin, ist vielleicht etwas
mit dem Objekttrager nicht in Ordnung.

4 Bei einigen Nicht-Agilent-Objekttragern mit halbtransparenten oder
undurchsichtigen Umrandungen kann es sein, dass der Scan-Bereich zu
nahe am undurchsichtigen Bereich des Glases liegt. Siehe ,Erstellen eines
neuen Scan-Bereichs mit dem Scan Region Editor” auf Seite 69.

5 Wenden Sie sich an Ihr Agilent Vertriebs- und Supportcenter.

Fiihren Sie folgende Schritte aus:

1 Stellen Sie sicher, dass der Strichcode nicht die Scan-Startposition blockiert.

2 Wiabhlen Sie einen kleineren Scan-Bereich.

3 Besteht das Problem fiir diesen Objekttrager weiterhin, ist vielleicht etwas
mit dem Objekttrager nicht in Ordnung.

4 Wenden Sie sich an |hr Agilent Vertriebs- und Supportcenter.

Fihren Sie folgende Schritte aus:

1 Offnen Sie die Scannerabdeckung.
2 Nehmen Sie den Halter aus dem Ausgangssteckplatz.
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Tabelle 4 Fehlermeldungen (Fortsetzung)

Fehlermeldung Beschreibung oder Losung

Cannot load chip, moving the arm may be  Fiihren Sie folgende Schritte aus:

unsafe. 1 Offnen Sie die Scannerabdeckung.
2 Wenn sich der Arm zum automatischen Beladen iiber dem Karussell
befindet, driicken Sie ihn vorsichtig bis zum Anschlag in den Scanner zuriick.
3 Besteht das Problem weiterhin, wenden Sie sich an |hr Agilent Vertriebs-
und Supportcenter.

Command timed out. Fihren Sie folgende Schritte aus:

1 Prifen Sie, ob das USB-Kabel mit dem Microarray-Scanner und dem PC-
Arbeitsplatz verbunden ist.

2 Schalten Sie den Microarray-Scanner aus und anschlieRend wieder ein.

Starten Sie das Scan-Steuerungsprogramm neu.

4 Besteht das Problem weiterhin, wenden Sie sich an lhr Agilent Vertriebs-
und Supportcenter.

w

Connection manager reports that there Magliche Ursachen fiir diesen Fehler:

are no instruments. « Der Microarray-Scanner ist méglicherweise nicht eingeschaltet oder Sie
haben den Microarray-Scanner eingeschaltet, aber nicht lange genug
gewartet, sodass der Microarray-Scanner den Selbsttest und die
Initialisierung nicht abschlieRen konnte. Wahlen Sie ,,0K", um die Scan-
Steuerungsmeldung zu schlieRen, warten Sie einige Minuten und versuchen
Sie es erneut.

* Der Microarray-Scanner ist méglicherweise nicht mit dem PC-Arbeitsplatz
verbunden. Priifen Sie, ob das USB-Kabel mit dem Microarray-Scanner und
dem PC-Arbeitsplatz verbunden ist. Ist das USB-Kabel nicht angeschlossen,
schlieRen Sie es erneut an, starten Sie den PC neu und schalten Sie den
Microarray-Scanner ggf. aus und anschlieRend wieder ein.

* Die Internet-Protokoll-Netzwerkeigenschaften (TCP/IP) fir den Scanner sind
méglicherweise geandert worden. Uberpriifen Sie, ob die IP-Adresse fiir die
lokale Verbindung des Scanners 10.0.0.1 und die Subnetzmaske
255.255.255.0 ist.

+ Die Windows XP-Firewall verhindert méglicherweise die Kommunikation.
Deaktivieren Sie die Firewall.

» Wenn Sie lhren PC-Arbeitsplatz neu gestartet haben, miissen Sie eventuell
den Microarray-Scanner ausschalten und anschlieRend wieder einschalten,
nachdem Windows neu gestartet wurde.
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Tabelle 4 Fehlermeldungen (Fortsetzung)

Fehlermeldung

Beschreibung oder Losung

Error ejecting chip. The chip was ejected
into the home slot.

Failed to communicate with connection
manager.

Lasers never became ready.

Missing or corrupt ChipRegions.ini file.

Fihren Sie folgende Schritte aus:

1 Schalten Sie den Scanner aus.

2 Offnen Sie die Scannerabdeckung.

3 Drehen Sie das Karussell manuell, bis der Ausgangssteckplatz nicht mehr
vom Arm zum automatischen Beladen blockiert wird.

4 Nehmen Sie den Objekttrager aus dem Ausgangssteckplatz.

5 Driicken Sie den Arm vorsichtig bis zum Anschlag in den Scanner zuriick.

6 Besteht das Problem weiterhin, wenden Sie sich an Ihr Agilent Vertriebs-
und Supportcenter.

Fihren Sie folgende Schritte aus:

1 Starten Sie den PC-Arbeitsplatz neu.
2 Schalten Sie den Microarray-Scanner aus und anschlieRend wieder ein.
3 Starten Sie das Scan-Steuerungsprogramm nach einigen Minuten neu.

Fihren Sie folgende Schritte aus:

1 Uberpriifen Sie, ob die Zahl im Spannungswahlschalter auf der Riickseite des
Scanners mit der Netzspannung iibereinstimmt.

2 Wenn Sie lhren PC-Arbeitsplatz neu gestartet haben, miissen Sie eventuell
den Microarray-Scanner ausschalten und anschlieRend wieder einschalten,
nachdem Windows neu gestartet wurde.

3 Besteht das Problem weiterhin, wenden Sie sich an |hr Agilent Vertriebs-
und Supportcenter.

Fihren Sie folgende Schritte aus:

1 Falls Sie Gber eine Sicherungskopie lhrer benutzerdefinierten
ChipRegions.ini-Datei verfiigen, kopieren Sie diese in das Verzeichnis C:\
Programme\Agilent\Microarray. Mit einer Sicherungskopie von
ChipRegions.ini kénnen Sie den Verlust und eine erneute Erstellung
benutzerdefinierter Scan-Bereiche vermeiden.

2 Falls Sie iiber keine Sicherungskopie verfiigen, durchsuchen Sie den Ordner
nach der Datei ChipRegions.bak und benennen Sie sie in ChipRegions.ini um.

3 Sind beide Dateien nicht vorhanden, installieren Sie das Scan-
Steuerungsprogramm erneut.

4 Wenden Sie sich an lhr Agilent Vertriebs- und Supportcenter.
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Tabelle 4 Fehlermeldungen (Fortsetzung)

Fehlermeldung

Beschreibung oder Losung

Not enough disk space to create file.

PMT calibration may be unstable. Using
last known PMT setting.

PMT calibration lost! Using factory
default settings.

Slide skipped because it is outside the
allowable thickness range or the selected
scan region contains an obstruction to
the initial focus positions.

The autoloader loading arm is in an
unknown location. It is unclear if it is safe
to move the carousel.

The chip carousel is not present. Please
place the carousel in the scanner and try
again.

The carousel may be misaligned. Please
remove the carousel, make sure that its
opening is aligned with home position
and reinsert the carousel.

Auf der Festplatte ist nicht genug Speicherplatz vorhanden, um eine Datei zum
Speichern der Scan-Daten zu erstellen. Sie konnen folgende Schritte ausfiihren:

+ Navigieren Sie zum Hauptmenii des Scan-Steuerungsprogramms und wahlen
Sie ein anderes Ausgabeverzeichnis auf einer anderen Festplatte.

+ Loschen oder verschieben Sie die Dateien von der aktuellen Festplatte. Siehe
.Schritt 5. Ubertragen von Dateien und Archivieren von Daten” auf Seite 48.

Sie kdnnen diesen Warnhinweis mit dem Werkzeug Reset Calibration
Warnings zuriicksetzen. Siehe ,Weitere Werkzeuge” auf Seite 75. Wird dieser
Warnhinweis weiterhin oder erneut angezeigt, wenden Sie sich an lhr Agilent
Vertriebs- und Supportcenter.

Sie kénnen diesen Warnhinweis mit dem Werkzeug Reset Calibration
Warnings zuriicksetzen. Siehe ,Weitere Werkzeuge” auf Seite 75. Wird dieser
Warnhinweis weiterhin oder erneut angezeigt, wenden Sie sich an Ihr Agilent
Vertriebs- und Supportcenter.

Fihren Sie folgende Schritte aus:

1 Uberpriifen Sie, ob sich auf dem iibersprungenen Objekttrager ein
Strichcode, Hybridisierungsriickstande oder andere nicht transparente
Hindernisse befinden, die die Ausgangsposition fiir den Fokus blockieren.
Die Ausgangsposition fiir den Fokus befindet sich 1 bis 2 mm links vom
Scan-Bereich auf der obersten Reihe des Scan-Bereichs.

2 Messen Sie die Glasdicke und tiberpriifen Sie, ob sie den Spezifikationen in
.Objekttragerspezifikationen” auf Seite 111 entspricht.

Fihren Sie folgende Schritte aus:

1 Offnen Sie die Scannerabdeckung.

2 Wenn sich der Arm zum automatischen Beladen iiber dem Karussell

befindet, driicken Sie ihn vorsichtig bis zum Anschlag in den Scanner zuriick.

SchlieRBen Sie das Scan-Steuerungsprogramm und starten Sie es neu.

4 Besteht das Problem weiterhin, wenden Sie sich an Ihr Agilent Vertriebs-
und Supportcenter.

w

Setzen Sie das Karussell in den Microarray-Scanner und starten Sie den
Karusselldurchlauf neu. Siehe , Schritt 2. Einlegen der Objekttrager in die
Halter” auf Seite 26.

Siehe ., Schritt 2. Einlegen der Objekttrager in die Halter” auf Seite 26.
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Tabelle 4 Fehlermeldungen (Fortsetzung)

Fehlermeldung

Beschreibung oder Losung

The slide failed to eject. Pressing OK will
re-initialize the instrument.

The software has detected a serious
sensor error that may have existed prior
to the installation of this version of
software.

Unable to lock instrument specified by
connection manager.

You must select a region to scan first.

You must select at least one dye channel.

Wenn Sie auf ,,0K” klicken, wird der Microarray-Scanner neu initialisiert.
Schlagt dies fehl, fithren Sie folgende Schritte aus:

1 Offnen Sie die Scannerabdeckung.

2 Wenn sich der Arm zum automatischen Beladen iiber dem Karussell
befindet, driicken Sie ihn vorsichtig bis zum Anschlag in den Scanner zuriick.
Wenden Sie keine Gewalt an, wenn sich der Arm nicht einfach bewegen
lasst.

3 SchlieBen Sie das Scan-Steuerungsprogramm und starten Sie es neu.

4 Besteht das Problem weiterhin, wenden Sie sich an Ihr Agilent Vertriebs-
und Supportcenter.

Wenden Sie sich an Ihr Agilent Vertriebs- und Supportcenter.

Fihren Sie folgende Schritte aus:

1 Starten Sie den PC-Arbeitsplatz neu.
2 Schalten Sie den Microarray-Scanner aus und anschlieRend wieder ein.
3 Starten Sie das Scan-Steuerungsprogramm neu.

Fihren Sie folgende Schritte aus, um einen Scan-Bereich in der Scan-Tabelle zu
erfassen, der nicht im gewahlten Profil enthalten ist:

1 Wabhlen Sie den Steckplatz bzw. die Steckplatze aus, fiir die Sie einen
Bereich erfassen méchten.

2 Klicken Sie auf den Abwaértspfeil neben der Auswahl.

3 Wahlen Sie aus der Liste der Scan-Bereiche einen Scan-Bereich aus. Siehe
.Andern von einzelnen Einstellungen der Scan-Tabelle” auf Seite 52.

4 Starten Sie den Scan-Vorgang oder Karusselldurchlauf.

1 Wabhlen Sie den Steckplatz bzw. die Steckplatze aus, dessen Farbstoffkanal
Sie dndern méchten.

2 Klicken Sie auf den Abwartspfeil neben der Auswahl.

3 Wabhlen Sie aus der Liste eine Einstellung fiir den Farbstoffkanal aus. Siehe
.Dye channel” auf Seite 55.
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Tabelle 4 Fehlermeldungen (Fortsetzung)

Fehlermeldung Beschreibung oder Losung

You must close the door first. Die Initialisierung des Microarray-Scanners und Scan-Vorgénge konnen bei
geoffneter Abdeckung des Microarray-Scanners nicht durchgefiihrt werden.
SchlieRen Sie die Abdeckung.

Warning: The laser power does not fall Warten Sie die erforderliche Aufwarmphase ab (etwa 30 Minuten), wenn die
within expected thresholds. Please Statusmeldung des Scan-Steuerungsprogramms ,Status Ready” lautet. Sie
contact an Agilent representative. kénnen diesen Warnhinweis mit dem Werkzeug ,,Reset Calibration Warnings”

zurlicksetzen. Siehe ,Weitere Werkzeuge” auf Seite 75. Wird dieser
Warnhinweis weiterhin oder erneut angezeigt, wenden Sie sich an Ihr Agilent
Vertriebs- und Supportcenter.

Das Scan-Steuerungsprogramm skaliert die TIFF-Datei so, dass die niedrigere
Laserleistung kompensiert wird.

Nicht in der Tabelle aufgefiihrte Fehlermeldungen

Die Tabelle fiihrt nicht alle méglichen Fehlermeldungen auf.
Falls Thnen eine Fehlermeldung angezeigt wird, die nicht
aufgefiihrt ist, und Sie das Problem nicht beheben kénnen,
fithren Sie folgende Schritte aus:

1 Notieren Sie sich die Fehlermeldung.
2 Starten Sie das Scan-Steuerungsprogramm neu.

3 Lost Schritt 2 das Problem nicht, fiihren Sie folgende
Schritte aus:

a Starten Sie den PC- Arbeitsplatz neu.

b Schalten Sie den Microarray-Scanner aus und
anschlieBend wieder ein.

¢ Starten Sie das Scan- Steuerungsprogramm neu.

4 Lost Schritt 3 das Problem nicht, wenden Sie sich an Ihr
Agilent Vertriebs- und Supportcenter.
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Dieses Kapitel enthilt Spezifikationen, Informationen zu
rechtlichen Bestimmungen und Anweisungen zum Prifen der
Spannung, falls das Gerat umgestellt wird.

In diesem Abschnitt werden die Spezifikationen fiir den
Microarray- Scanner beschrieben. Weitere Informationen zu
den Spezifikationen fiir den PC- Arbeitsplatz finden Sie im
Benutzerhandbuch des PCs.

In diesem Abschnitt werden die Spezifikationen fiir Glas und
Strichcodes erlautert, die vom Scanner erkannt werden.

Dieser Abschnitt befasst sich mit den rechtlichen
Bestimmungen zu Betriebsgerdauschen, Recycling und
Entsorgung, elektromagnetischen Storungen sowie mit den
Sicherheitsbestimmungen, denen der Microarray-Scanner
entspricht.

In diesem Abschnitt wird beschrieben, wie Sie die
Eingangsspannung nach dem Umstellen des Geréats priifen
konnen.
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Microarray-Scannerspezifikationen

Ungefahre
MaRe

Gewicht

Stromversorgung

Sicherungen

Temperaturbereich

Feuchtigkeit

Hohe

Verwendung

Laser-
informationen

Der Microarray-Scanner hat folgende Spezifikationen:
Hoéhe: 97 cm; mit geschlossener Abdeckung 55 cm
Breite: 91 cm

Tiefe: 71 cm

Diese Maf3e weisen die maximale Hohe und Breite bei
offener Abdeckung und einem Abstand von 80 mm in der
Breite fiir eine angemessene Beliiftung aus.

99 kg
100, 120, 220 oder 240 V Wechselstrom bei 4 A
50/60 Hz

Zwei Netzsicherungen: T4A, 250 V Wechselstrom
(Teilenr. 2110-1309)

Eine Lasersicherung: T500mA, 250 V Wechselstrom
(Teilenr. 2110-0458)

Betrieb: 15° bis 30?
Lagerung: -20° bis +50?
Betrieb: 15% bis 95% relative Luftfeuchtigkeit bei 30°C

Kann empfindlich auf kondensierende Luftfeuchtigkeit
reagieren. Befolgen Sie die in Kapitel 5 genannten
Sicherheitsvorkehrungen.

Maximale Betriebshohe: 2.300 m
Maximale Lagerungshohe: 4.600 m
Zur Verwendung in geschlossenen Raumen

Anregungswellenldngen:
¢ SHG-YAG-Laser: 532 nm
¢ Helium- Neon- Laser (HeNe): 633 nm
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Maximaler
Scan-Bereich

Vorgeschlagener
Microarray-
Druckbereich

Unterstiitzte
Farbstoffe

Auflosung
(PixelgroRe)

Pixelpositionierungs-
fehler

GleichmaRBigkeit

Scan-Zeit

Referenz 6

Leistung: 20 mW bei 532 nm und 23 mW bei 633 nm, beide
geregelt auf 13 mW

Agilent G2565CA: 71 mm x 21,6 mm

1 mm Kkleiner als der Scan-Bereich rechts, 2 mm Kkleiner als
der Scan-Bereich links und 0,6 mm kleiner als der Scan-
Bereich oben und unten. Bei Nicht- Agilent- Objekttragern ist
der Druckbereich um die Array-Drucktoleranz kleiner als
diese Angaben.

Cyanine-3 (Cy-3) und Cyanine-5 (Cy-5) und Farbstoffe, die
Cy-3 und Cy-5 dhneln sowie die Farbstoffe Alexa 647, 555
und 660

2, 3, 5 oder 10 Mikrometer

< 1 Pixel bei einer Aufléosung von 5 Mikrometern

5% VK fiir globale Ungleichméfigkeit, die durchschnittliche
lokale Ungleichmifigkeit liegt normalerweise bei 1% bei
100um- Merkmalen.

Tabelle 5 Scan-Zeit fiir einzelne und duale Scan-Vorgéange fiir den
Agilent HD-Scan-Bereich 61 mm x 21,6 mm

Auflosung Scan-Zeit, min.

Einzeldurchgang mit 20
2 Mikrometern

Einzeldurchgang mit 15
3 Mikrometern

Einzeldurchgang mit 8
5 Mikrometern

Einzeldurchgang mit 8
10 Mikrometern

Doppeldurchgang mit 40
2 Mikrometern
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Dynamischer Bereich

Tabelle 5 Scan-Zeit fiir einzelne und duale Scan-Vorgéange fiir den
Agilent HD-Scan-Bereich 61 mm x 21,6 mm

Auflésung Scan-Zeit, min.

Doppeldurchgang mit 30
3 Mikrometern

Doppeldurchgang mit 16
5 Mikrometern

Dynamischer 16-Bit- Bereich von >10% fiir einzelne Scan-
Vorgénge

Dynamischer 20- Bit- Bereich von >10° fiir einzelne Scan-
Vorgénge

Erweiterter dynamischer Bereich (eXtended Dynamic Range,
XDR) von >10% fiir duale Scan- Vorgiange
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Objekttragerspezifikationen

Scan-MaRe

Der Scan-Bereich ist in Abbildung 40 dargestellt. Alle
Angaben sind in Millimeter und die untere rechte Glasseite
ist der Referenzpunkt.

- 76.2+0.25-1.4 >

25.4+0.7

or-0.45
| I

Barcode Label

9
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—1.
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|—
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Abbildung 40 Scan-Bereich fiir Agilent G2565CA

Glasspezifikationen

Der Microarray-Scanner verwendet Objekttragerhalter,

um die Microarrays in das Karussell zu setzen und
herauszunehmen. Diese Halter sind fiir Glasobjekttrager
der Standardgréfle 76 mm x 26 mm vorgesehen.

Die genauen Spezifikationen fiir das Glas lauten wie folgt:
e 25,4 mm breit, -0,45 mm oder +0,7 mm

* 76,2 mm lang, +0,25 mm oder -1,4 mm

e 1 mm dick (+/-0,1 mm)

¢ Keine gespiegelten Objekttriager

* Hohe Qualitat mit geringer Eigenfluoreszenz

* Brechungsindex von 1,510 bis 1,515
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Spezifikationen zum Strichcode und Strichcodeetikett

Strichcodespezifikationen fiir Agilent Objekttrager

Der Scanner G2565CA liest Strichcodes, die auf der aktiven
Seite des Objekttriagers positioniert sind.

Um eine Abwartskompatibilitit mit den Scanner der

Serie G2565AA sicherzustellen, haben Agilent Microarrays
weiterhin Strichcodes auf beiden Seiten. Das Etikett mit der
Beschriftung ,Agilent” markiert die aktive Seite, das Etikett
mit dem numerischen Wert die inaktive Seite.

Double-barcoded slide example

=
=l
SIDE 1 £ = Inactive Glass Surface
Sm
|
=
i - .
=z = Active Active
SIDE 2 §= Microarray Microarray
] Surface Surface
u
=

Abbildung 41 Positionierung des Strichcodes fiir Agilent Objekttrager im
Vergleich zur Microarray-Oberflache

Strichcodespezifikationen fiir Nicht-Agilent-Objekttrager

¢ Die maximale Dicke des Strichcodeetiketts betragt 0,2 mm.
Stellen Sie sicher, dass das Etikett keine Blasen wirft.
Kleben Sie keine neuen Etiketten auf alte Etiketten oder
erneuern Sie Etiketten, die sich bereits ablosen.
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¢ Kleben Sie keine Strichcodeetiketten auf Objekttrager,
deren Scan-Bereich grofRer als 61 mm ist. Die Objekt-
trager-ID oder der Strichcode muss fiir Objekttriger,
deren Scan-Bereich grofRer als 61 mm ist, manuell ein-
gegeben werden.

¢ Der Abstand zwischen der Kante des Microarray-Scan-
Bereichs und des Strichcodeetiketts darf fiir Objekttrager
mit Strichcode nicht kleiner als 4 mm sein.

Standard-Scan-Bereich

Bereich fiir das
Strichcodeetikett

Abbildung 42 Strichcodepositionierung auf Nicht-Agilent-Objekttragern

¢ Die Breite des Strichcodeetiketts sollte etwa 6 mm
betragen; die empfohlene Breite des Strichcodeetiketts
bezieht sich auf die Verwendung mit dem 61 mm Scan-
Bereich. Grof3ere oder langere Strichcodeetiketten kénnen
verwendet werden, wenn der Scan-Bereich proportional
vergrofRert wird.

¢ Die Strichcodeetiketten sollten so schmal sein, dass sie
nicht gegen die Nasen der Objekttrigerhalter stof3en.

¢ Die maximal zuldssige Neigung bei der Positionierung des
Strichcodeetiketts auf dem Objekttriager betragt +3°.

Der Strichcode muss folgende Anforderungen erfiillen:

* Der leere Bereich (der Bereich zwischen der Kante des
Etiketts und dem Anfang bzw. Ende des Strichcodes) ist
mindestens 10 Mal so groff wie das X-Mafd auf jeder Seite
des Strichcodes.
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¢ Die Strichcodelinien miissen parallel zur langen Kante des
Objekttragers mit einer Neigungstoleranz von +3°
ausgerichtet sein.

¢ Agilent bietet Unterstiitzung fiir folgende
Strichcodeformate:

Code 128: Nicht- Agilent- Strichcodes mit 12 Stellen
dirfen nicht mit einer 2 beginnen

CODABAR: maximal 8 Stellen; Mindestlinienbreite =
0,15 mm

Code 39: maximal 8 Stellen; Mindestlinienbreite
0,15 mm

Code 93: maximal 8 Stellen; Mindestlinienbreite
0,15 mm

¢ Die Mindesthohe des Strichcodes betragt
Code 128: 15% der Strichcodelinge fiir Code 128

Code 39, Code 93, CODABAR: 5 mm oder 15% der
Strichcodelidnge, je nachdem, welcher Wert grofder ist
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Informationen zu rechtlichen Bestimmungen

English

Deutsch

Wenden Sie sich fiir weitere
Informationen zu Recycling und
Entsorgung an Agilent
Technologies.

Storaussendung

Dieser Abschnitt enthalt Informationen zu den rechtlichen
Bestimmungen fiir den Microarray- Scanner.

Verwendung ausschlieBlich fiir Forschungszwecke

Der Agilent Microarray- Scanner G2565CA ist
AUSSCHLIESSLICH FUR FORSCHUNGSZWECKE vorgesehen.

Angaben zu Betriebsgerdauschen
Angaben des Herstellers:

This statement is provided to comply with the
requirements of the German Sound Emission Directive,
from 18 January 1991. Sound Pressure Lp < 70 dB(A), at
operator’s position, normal operation, according to EN
27779 (Type Test).

Die folgende Information wird in Ubereinstimmung mit
den Anforderungen der Maschinenldrminformationsverord-
nung vom 18. Januar 1991 erteilt. Schalldruckpegel am
Arbeitsplatz bei normalem Betrieb, Lp < 70 dB(A), nach
EN 27779 (Typprifung).

Recycling und Entsorgung

Dieses Gerat kann am Ende seiner Lebensdauer recycelt
werden. Bitte entsorgen Sie dieses Gerdt gemifd den lokalen
Vorschriften.

Elektromagnetische Storungen

Der Scanner ist zur Verwendung mit abgeschirmten Kabeln
vorgesehen.

Erfillt die Anforderungen zur Stéraussendung fiir Gerite der
Klasse A gemafd EN 61326-1. Diese Gerite sind nicht zur
Verwendung in Wohngebieten vorgesehen.
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Storfestigkeit

Canada

Dieses Gerat erfiillt die Anforderungen zur Storfestigkeit
gemifl EN IEC 61326-1 fiir nicht tiberwachte, nicht
gewerbliche Umgebungen. Detaillierte Angaben erhalten
Sie in der beiliegenden Konformitatserklarung.

This ISM (Industrial- Scientific- Medical) device complies with
Canadian ICES-001.

Cet appareil ISM est conforme a la norme NMB-001 du
Canada.

Sicherheitsinformationen

Dieser Scanner erfiillt die Anforderungen folgender
Sicherheitsstandards:

CAN/CSA-C22.2 Safety Requirements for Electrical

No. 1010.1 - 92 Equipment for Measurement, Control, and
Laboratory Use, Part 1: General Requirements
(Includes Amendment 1)

CAN/CSA-C22.2 No. Amendment 2 to CAN/CSA-C22.2 No.1010.1-92,

1010.1B-97 Safety Requirements for Electrical Equipment for
Measurement, Control, and Laboratory Use,
Part 1: General Requirements

UL 3101.1 Electrical Equipment for Laboratory Use:
Part 1: General Requirements
UL 3111-1 Equipment for Measurement Use;
Part I: General Requirements
ISA §82.01-1994 Safety Standards for Electrical and Electronic

Test, Measuring, Controlling, and Related
Equipment - General Requirements

EN 61010-1 Sicherheitshestimmungen fiir elektrische Mess-,
Steuer-, Regel- und Laborgeréte,
Teil 1: Allgemeine Anforderungen

EN 60825-1 Sicherheit von Lasereinrichtungen, Teil 1:
Klassifizierung von Anlagen, Anforderungen und
Benutzer-Richtlinien

EN60825-1

(einschlieBlich Anderung 1:1992 und Anderung 2:1995)
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¢ Verschmutzungsgrad: 2

¢ Installationskategorie: II

¢ Gerat der Klasse 1; erfordert ein Erdungssystem
¢ Lasereinrichtung der Klasse 1

¢ Einrichtung genehmigt gemiafd UL/CSA
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Priifen der Eingangsspannung

Uberpriifen der Eingangsspannung

Wenn Sie den Microarray-Scanner das erste Mal einschalten
oder ihn an einen anderen Standort gestellt haben, miissen
Sie sich vergewissern, dass die Eingangsspannung an der
Riickseite des Gerits korrekt eingestellt ist. Vier Werte
konnen fir die Eingangsspannung gewahlt werden:

* 100 V Wechselstrom
e 120 V Wechselstrom
e 220 V Wechselstrom
e 240 V Wechselstrom
1 Betrachten Sie den Microarray-Scanner von der Riickseite.

2 Die Einstellung fiir die Eingangsspannung wird in einem
kleinen Fenster angezeigt.

Anzeigefenster
fiir die Einstel-
lung der Ein-
gangsspannung

Abbildung 43 Anzeigefenster fiir die Einstellung der Eingangsspannung

3 Stimmen die Einstellung fiir die Eingangsspannung und
die Netzspannung iiberein, konnen Sie den Microarray-
Scanner einschalten.

Stimmen die Einstellung fiir die Eingangsspannung und
die Netzspannung nicht iberein, miissen Sie die
Einstellung dndern.
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Andern der Spannungseinstellung
1 Ziehen Sie das Stromkabel ab.

m Ziehen Sie das Stromkabel immer ab, bevor Sie die Einstellung fiir
die Eingangsspannung dndern.

2 Heben Sie mit einem kleinen Schlitzschraubendreher die
kleine Plastiknase an der unteren Kante des Sicherungs-
halters an, bis sie entriegelt ist.

Sicherungshalter

Abbildung 44 Entfernen des Sicherungshalters fiir das Netzteil

3 Nehmen Sie den Sicherungshalter heraus.
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4 Entfernen Sie den Spannungswahlschalter mit einer
Spitzzange.

Spannungswabhlschalter

Sicherungshalter

Abbildung 45 Entfernen des Spannungswahlschalters aus dem
Sicherungshalter

b Positionieren Sie den Spannungswahlschalter so, dass die
sichtbare Zahl mit der Netzspannung tibereinstimmt.

6 Driicken Sie den Sicherungshalter zuriick, bis er einrastet.
7 Schlielen Sie das Stromkabel an.
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